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LIMITED USE LICENSE AGREEMENT 
You should carefully read the following terms and conditions before opening this package. By opening this package 
you are agreeing to become bound by the terms of this agreement and indicating your acceptance of these terms and 
conditions. If you do not agree with them, you should return the package unopened to Geophysical Survey Systems, 
Inc. 

Geophysical Survey Systems, Inc. (GSSI), an OYO Corporation, provides the computer software ("RADAN 6.x") 
contained on the medium in this package, and licenses its use. You assume full responsibility for the selection of 
RADAN 6.x to achieve your intended results and for the installation, use and results obtained from the Program. 

LICENSE 

a) In consideration of the payment of a license fee, you are granted a personal, non-transferable license to use 
RADAN 6.x under the terms stated in this Agreement. You own the diskette or other physical media on which 
RADAN 6.x is provided under this Agreement, but all title and ownership of RADAN 6.x and enclosed related 
documentation "("Documentation"), and all other rights not expressly granted to you under this Agreement, remain 
in Geophysical Survey Systems, Inc.; 

b) RADAN 6.x must be used by you only on a single computer or as a traveling license via use of a USB Hardware 
Security Key; 

c) You and your employees and agents are required to protect the confidentiality of RADAN 6.x. You may not 
distribute or otherwise make RADAN 6.x or Documentation available to any third party; 

d) You may not copy or reproduce RADAN 6.x or Documentation for any purpose except you may make one (1) 
copy of RADAN 6.x if RADAN 6.x is not copy-protected, in machine readable or printed form for backup purposes 
only in support of your use of RADAN 6.x on a single computer. You must reproduce and include the Geophysical 
Survey Systems, Inc. copyright notice on the Backup copy of RADAN 6.x;  

e) Any portion of RADAN 6.x merged into or used in conjunction with another program will continue to be the 
property of GSSI and subject to the terms and conditions of this Agreement. You must reproduce and include the 
copyright notice on any portion merged into or used in conjunction with another program; 

f) You may not sublease, assign, or otherwise transfer RADAN 6.x or this license to any other person without the 
prior written consent of GSSI. Any authorized transferee of RADAN 6.x will be bound by the terms and conditions 
of this Agreement; and 

g) You acknowledge that you are receiving only a Limited License to use RADAN 6.x and Documentation and 
GSSI retains title to RADAN 6.x and Documentation. 

You acknowledge that GSSI has a valuable proprietary interest in RADAN 6.x and Documentation. 

You may not use, copy, modify, or transfer RADAN 6.x or Documentation, or any copy, modification, or merged 
portion, in whole or in part, except as expressly provided for this Agreement. 

If you transfer possession of any copy, modification, or merged portion of RADAN 6.x or Documentation to another 
party, your license is automatically terminated. 

TERM 
The license granted to you is effective until terminated. You may terminate it at any time by returning RADAN 6.x 
and Documentation to GSSI together with all copies, modifications, and merged portions in any form. The license 
will also terminate upon conditions set forth elsewhere in this Agreement or if you fail to comply with any term or 
condition of this Agreement. You agree upon such termination to return RADAN 6.x and Documentation to GSSI 
together with all copies, modifications, and merged portions in any form. Upon termination, GSSI can also enforce 
any rights provided by law. The provisions of this Agreement which protect the proprietary rights of GSSI will 
continue in force after termination. 
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LIMITED WARRANTY 

GSSI warrants as the sole warranty provided to you that theCD on which RADAN 6.x is furnished will be free from 
defects in materials and workmanship under normal use and conditions for a period of ninety (90) days from the date 
of delivery to you as evidenced by a copy of your receipt. No distributor, dealer, or any other entity or person is 
authorized to expand or alter either this warranty or this Agreement; any such representation will not bind GSSI. 

GSSI does not warrant that the functions contained in RADAN 6.x will meet your requirements or that the operation 
of RADAN 6.x will be uninterrupted or error-free. 

Except as stated above in this section, RADAN 6.x and Documentation are provided "as is" without warranty of any 
kind, either express or implied, including but not limited to, the implied warranties of merchantability and fitness for 
a particular purpose. You assume the entire risk as to the quality and performance of the program and 
documentation. Should the program prove defective, you (and not GSSI or any authorized GSSI distributor or 
dealer) assume the entire cost of all necessary servicing, repair, or correction. 

This warranty gives you specific legal rights, and you may also have other rights which vary from state to state. 
Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you. 

LIMITATION OF REMEDIES 

GSSI's entire liability and your exclusive remedy will be: 

a) The replacement of any diskette not meeting GSSI's "Limited Warranty" explained above and which is returned to 
GSSI with a copy of your receipt; or 

b) If GSSI is unable to deliver a replacement diskette which conforms to the warranty provided under this 
Agreement, you may terminate this Agreement by returning RADAN 6.x and Documentation to GSSI and your 
license fee will be refunded. 

IMPORTANT: If you must ship RADAN 6.x and Documentation to GSSI, you must prepay shipping and either 
insure RADAN 6.x and Documentation or assume all risk of loss or damage in transit. To replace a defective 
diskette during the ninety (90) day warranty period, if you are returning the medium to GSSI, please send us your 
name and address, the defective medium and a copy of your receipt at the address provided below. 

In no event will GSSI be liable to you for any damages, direct, indirect, incidental, or consequential, including 
damages for any lost profits, lost savings, or other incidental or consequential damages, arising out of the use or 
inability to use RADAN 6.x and Documentation, even if GSSI has been advised of the possibility of such damages, 
or for any claim by any other party. Some states do not allow the limitation or exclusion of liability for incidental or 
consequential damages, so the above limitation or exclusion many not apply to you. In no event will GSSI's liability 
for damages to you or any other person ever exceed the amount of the license fee paid by you to use RADAN 6.x, 
regardless of the form of the claim. 

U.S. GOVERNMENT RESTRICTED RIGHTS 

RADAN 6.x and Documentation are provided with restricted rights. Use, duplications, or disclosure by the U.S. 
Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of the Rights in Technical Data and 
Computer Software clause at 252.277-7013. Contract/manufacturer is Geophysical Survey Systems, Inc., 
40 Simon Street, Nashua, NH  03060-3075. 

GENERAL 

This Agreement is governed by the laws of the State of New Hampshire (except federal law governs copyrights and 
registered trademarks). If any provision of this Agreement is deemed invalid by any court having jurisdiction, that 
particular provision will be deemed deleted and will not affect the validity of any other provision of this Agreement. 

Should you have any questions concerning this Agreement, you may contact GSSI by writing Geophysical Survey 
Systems, 40 Simon Street, Nashua, NH  03060-3075 U.S.A. 

You acknowledge that you have read this agreement, understand it and agree to be bound by its terms and 
conditions. You further agree that it is the complete and exclusive statement of the Agreement between you and 
GSSI which supersedes any proposal or prior Agreement, oral or written, and any other communications between us 
relating to the subject matter of this Agreement. 
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Introduction 
This Handbook is intended to “de-mystify” the entire process of GPR inspection of asphalt paved 
roadways and help you get the most out of your time and money investment in the application. The 
ultimate goal of this guidebook is to help you collect good data and interpret that data in order to give 
usable information. It is important to note that this guide is not meant as an exhaustive treatment of the 
subject. There is a large body of literature on the non-destructive testing of asphalt road surfaces and you 
are encouraged to consult the reference list at the end of the guide for suggestions on further reading. 

If you experience operation problems with your system or software, GSSI Technical Support can be 
reached 9am-5pm US Eastern Time, at 1-800-524-3011, or at (603)893-1109 (International). We are also 
on the Web at https://support.geophysical.com. 

This Handbook is divided into four main sections: 

1 Ground Penetrating Radar (GPR) for Road Structures theoretical overview. We discuss the 
technology of GPR with special reference to this application. 

2 Hardware setup on a survey vehicle. Due to the high variety of vehicles that you could use 
for your survey, this section is very general. We will use the GSSI survey vehicle as an 
example and make recommendations for other general types of vehicle. 

3 Collecting the data. We will present the techniques for data collection. Possible problems 
will be addressed. 

4 Data processing and interpretation. This is done with GSSI’s RADAN data analysis 
program and the Road Structure Assessment software module. 

Road Structures are defined here as the layered asphalt paving and any geo-textiles, base and sub-base 
materials. While it is sometimes possible to detect buried utility lines, that particular application is not a 
focus of the RoadScan technique.  

The RoadScan technique described here involves the use of a GSSI SIR-20 control unit, Model 4105, 
4105NR, 4108, or 4108(F) Horn antennas, and some type of distance measure instrument (DMI). The unit 
is mounted on a vehicle for high speed data acquisition. Data processing is done with GSSI’s RADAN 
processing software with Road Structure Assessment module. 

https://support.geophysical.com/
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Chapter 1: Ground Penetrating Radar for 
Road Structures Theoretical Overview 

This section will introduce you to the technology of Ground Penetrating Radar (GPR) and explain certain 
points in detail that you will need to understand to work with the RoadScan technique.  

1.1 Major Equipment Components for Road Structure 
Analysis 
A ground penetrating radar system consists of three main components. 

The Control Unit 
The control unit contains the radar electronics that generate the radar trigger pulse that travels to the 
antenna. In addition to the radar computer board, the control unit also has a computer which acts as a data 
storage medium, post-processing platform and a user control interface to allow you to control the survey. 
The control unit for the RoadScan system is the SIR-20. 

Note: GSSI does not support the SIR-3000 control unit for use with air-launched Horn antennas. 

The Antenna 
The antenna takes the trigger pulse from the control unit and shapes it into a radar wave pulse which is 
transmitted into the asphalt. It also receives any reflections and sends them back to the control unit for 
storage. Antennas come in different frequencies with the frequency choice determining the resolution. 
The higher the antenna frequency, the finer the resolution. Antennas are usually referred to by their 
“center frequency” values. Since GPR antennas transmit over a very wide frequency band, it is 
convenient to refer to them by the frequency at which they transmit most of their signal. The two main 
antennas used for RoadScan are the Horn antennas Model 4105 (2 GHz) and the Model 4108 (1 GHz). 
The 2 GHz antenna is the current antenna of choice for road survey because it combines excellent 
resolution with reasonable depth penetration. 

Typically, GPR antennas must be used in contact with the ground surface in order to get effective 
penetration (coupling). The Horn antennas are a specialized design that allows them to be used above the 
ground surface and still get effective penetration. This is possible because the transmitter and receiver 
antennas are shaped into A “V” shape that focuses the signal. The Horn antennas thus have three main 
benefits over a ground coupled antenna. The first is that it allows you to survey at high speeds. A ground 
coupled antenna in contact with the road surface would be worn away to a nub within a few miles. The 
second advantage is that since we are able to get a clear reflection from the pavement surface, thickness 
measurements from Horn antennas are much more accurate than ground-coupled antennas. The third 
advantage is the calibration technique that allows the asphalt velocity to be calculated at each scan 
location. This produces an accurate depth determination without the need for calibration cores. 
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The Positioning System 
Asphalt thickness data would not be much use if you did not know where along the road each data point 
was taken. The job of a positioning system is to allow you to relocate your data to the point at which it 
was taken. The positioning system commonly takes the form of a wheel-mounted distance measuring 
instrument (DMI).  

You will also need: 

Some long tape measures. Surveyor’s tape measures work well. 

A 4 × 4 foot (1.2 × 1.2 m) minimum size sheet of metal for the antenna calibration. This metal plate 
should be clean and smooth. Aluminum works best. 

1.2 GPR for RoadScan Theory of Operation 
RADAR is an acronym for RAdio Detection And Ranging. It works by sending out electromagnetic 
energy and recording the reflections. The elapsed time between transmission and reception can be used to 
calculate the distance to the target. Furthermore, the strength of the reflection can provide insight on 
certain properties of the target material. 

GPR shares a lot in common with aerial search radar, but there are some differences. GPR is impulse 
radar. That means that the GPR system is sending short pulses of low-level electromagnetic (EM) energy 
into a material and measuring the effects that the material has on the reflection of the transmitted pulse. 
By analyzing the received radar reflections from the layer boundaries within a material, we can infer a 
few things about the material. Although the usual main goal of a RoadScan survey is to map asphalt layer 
thickness, research shows that GPR has the potential to provide usable information on a host of asphalt 
physical properties. 

We can measure asphalt thickness with GPR by transmitting a pulse into asphalt and measuring the time 
elapsed between the received reflection from the top of the pavement and the reflection from the bottom 
of the pavement layer. This is known in GPR studies as the two-way travel time (TWTT) in the material, 
and is measured in nanoseconds (ns). The other piece of information that we need to know is the travel 
velocity of that radar pulse in the material. If we know the TWTT and the velocity of the material, then it 
is a simple matter to figure out the distance traveled. It is very easy to find the TWTT since that is the 
primary piece of information that the GPR is gathering, but figuring the velocity is a bit more involved 
because velocity changes with different materials. The reason that radar is an excellent tool for ranging 
aircraft is because the velocity of radar energy in air is well established and nearly consistent no matter 
the weather or location in the world. 

Another piece of information that we can measure is the amplitude of the reflection. Knowing the strength 
of the reflection allows us to infer the amount of energy that was transmitted across the boundary between 
materials. We can then use the Horn antenna velocity processing mathematics to figure out the velocity of 
the radar energy through different media at each individual scan location. 

Radar Wave Velocity and Figuring out the Depth of Features 
GPR energy will travel (propagate) through different materials in different ways. Each material will allow 
GPR energy to move through it at a certain velocity. That velocity can be different for every type of 
material, so it is the material that sets the speed of the radar pulse. GPR energy moves at its fastest in air, 
(300 mm/ns or 11.8 in/ns) and slowest in water (33 mm/ns or 1.3 in/ns). If we are interesting in mapping 
layer thickness, then we will need to figure out that propagation velocity.  
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Asphalt has a generally “fast” velocity of 130-175 mm/ns (5.1-6.9 in/ns). We cannot simply have one 
single value for asphalt that is widely applicable everywhere because asphalt mixes can vary enormously 
in terms of composition, chemistry, air/water content, age and reactions to weathering. When trying to get 
thickness from layers of unknown velocity, there are really two ways to approaches: ground truthing and 
Horn antenna processing. 

Ground Truth 
We can get that velocity number a few different ways. The first is by ground truthing. Ground truthing 
provides the radar analyst with a known layer thickness at a given point. Since we have the travel time of 
the reflection, it is a simple matter to figure the velocity because: 

t
dv =  

where: 

v = velocity, 

d = measured depth of object or interface, 

t = travel time. Note that your radar is recording TWTT, so remember to divide that time by 2. 

Ground truthing is not always possible or practical for some applications. To get accurate depths on some 
layers on a road surface would require the taking of many cores. Over many miles of road, this may mean 
that the analyst is forced to take several or several dozen individual cores to get accurate data.  

Horn Antenna Processing 
An alternative to ground truthing for layer thickness is to scan the area with an air-launched Horn antenna 
and to apply the specialized Horn antenna data processing and layer interpretation steps in the RADAN 
software.  

Horn antenna processing allows us to get the velocity of the radar energy in the material by comparing the 
reflection strengths (amplitudes) from a pavement layer interface with a perfect reflector (a metal plate) 
acquired at the same height. The actual pavement layer reflections will be weaker than the perfect metal 
plate reflector because some of the energy penetrates the asphalt. We can use this difference between the 
perfect reflector and the pavement layer reflector, along with the known velocity of GPR energy in the 
upper layer to back-calculate the propagation velocity in the individual layers. We also apply a correction 
factor to account for any beam spreading. The following is a discussion of the mathematics behind the 
technique. 

The first step is to extract all of the pertinent information from the data. Typically, a calibration scan is 
obtained with the horn antenna placed over a metal plate at the same elevation as a scan obtained over 
pavement. Figures 1 and 2 show the parameters extracted from the respective scans. At this time we are 
disregarding an optional scan also collected with the antenna radiating in free space. This is done for  
2 reasons: (1) very similar results were obtained between data processed with and without the air-scan 
subtraction, (2) it is often difficult to obtain a high fidelity air scan in the field.  
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Figure 1: Information extracted from metal plate calibration scan. 

 
Figure 2: Sample of Horn antenna data. 

  

where: 

td  = time corresponding to negative peak of 
direct-coupling arrival, 

Admp = amplitude of positive peak of direct-
coupling arrival in metal plate scan, 

Admn = amplitude of negative peak of direct-
coupling arrival in metal plate scan, 

tp  = time corresponding to positive peak of 
metal plate surface reflection arrival,  

Amp = amplitude of positive peak of metal 
plate reflection, and 

Amn = amplitude of negative peak preceding 
positive peak of metal plate reflection. 

where: 

td  = time corresponding to negative peak of 
direct-coupling arrival, 

Adp = amplitude of positive peak of direct-
coupling arrival in pavement scan,  

Adn = amplitude of negative peak of direct-
coupling arrival in pavement scan, 

tp  = time corresponding to positive peak of 
pavement surface reflection arrival, 

App = amplitude of positive peak of pavement 
surface reflection, 

Apn = amplitude of negative peak preceding 
positive peak of pavement surface reflection, 

tb  = time corresponding to positive peak of 
pavement bottom reflection arrival, and 

Abp = amplitude of positive peak of pavement 
bottom reflection, 
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Figure 3: Shows the geometry associated with the reflection from the pavement surface  
and the direct-coupling. 

The parameters shown in Figures 1 and 2 are extracted from data obtained from the horn antenna 
positioned over a metal plate and the pavement, respectively. The “A” parameters are amplitudes. The “t” 
parameters are travel times. The amplitudes and travel times of the reflection from the pavement bottom 
(Abp and tb) are typically obtained after a template subtraction of a metal plate scan from the data scan 
(this is not shown in Figure 2). 

The antenna height, h, is back-calculated using the Equation 1 and solving for h. 

 

22
1 )2(2)( xhVttt cdp +=+−  Equation 1 

where: 

tc  = time constant that corrects for the difference in the arrival time of the positive peak of the 
direct-coupling and the true time-zero. (This value was back-calculated using the same equation 
and a series of measurements over a metal plate obtained at known heights. 

V1  = propagation velocity of radar waves in free space, 

h = antenna height above pavement or metal plate, and 

x = ½ bistatic separation between transmitting and receiving antennas. 
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The radar wave propagation velocity in pavement is calculated using Equation 2. 

 

222
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VV  Equation 2 

where: 

V2  = propagation velocity of radar waves in pavement, 

θi  = angle of incidence, and 

ρ  = reflection coefficient at pavement surface for angle of incidence θi. 

 

Equations 3-4 show how θi and ρ are calculated using known parameters.  
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The last parameter necessary for calculating the thickness of the pavement is the round-trip travel time of 
the reflection from the pavement bottom. This value is calculated using the relation shown in Equation 5. 

 

cdbtot tttt +−=  Equation 5 
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Figure 4 shows the more complicated ray path geometry of a ray reflecting from the bottom of the 
pavement.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 4: Geometry of ray path reflecting from pavement bottom. 

 

The total travel time of this ray is described by Equation 6.  
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where: 

x  = ½ separation distance between transmitting and receiving antennas, 

a  = distance between midpoint of antennas and surface location where incident ray refracts through 
the interface, 

d  = thickness of layer, 

h  = height of antenna, 

V1  = propagation velocity in medium 1,  

V2  = propagation velocity in medium 2, and 

ttot  = total travel time of wavefront reflecting from bottom of layer. 
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The 2 unknowns in Equation 6 are “a” and “d”. The unknown “d” can be removed from the equation 
using Equations 7 and 8. 

 

tan(θt) = a/d   Equation 7. 

 

sin(θt) = (V2/V1)sin(θi)  Equation 8. 

 

where: 

θi  = incidence angle, and 

θt  = transmission angle. 

 

Incorporating Equations 7 and 8 in Equation 6 results in a messy 4th order polynomial equation in which 
the only unknown is  “a”. The 4th order polynomial equation is solved using numerical techniques. Then 
the value “a” is plugged back into Equation 6 to back-calculate “d”.  

 

Don’t Panic!  
These equations and this proof are included to illustrate mathematically why the RoadScan Horn 
processing technique is scientifically sound. You do not have to use them. We use them automatically in 
the processing component. We will discuss an easy step-by-step operation guide later in this handbook. 

The above proofs can be boiled down into a few statements about Horn antenna processing. Horn antenna 
processing works because the antenna is held above the ground. This allows us to get strength of 
reflection from the surface. We then get the strength of reflection at any layer interface. This is compared 
to the surface reflection and the total transmitted power in order to get the radar wave velocity in the 
pavement. If we have velocity and we have the travel time, then it is easy to calculate the depth 
automatically. 
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1.3 Understanding RoadScan GPR Data 

 
Figure 5: Raw RoadScan GPR File. 

Figure 5 shows a data file as it would look during collection and before Horn antenna processing. The 
data is shown in a linescan format. The data is a two-dimensional plot of reflection time and strength with 
distance. The vertical scale bar on the left of the figure shows reflection time in nanoseconds. This is the 
TWTT of the particular reflection. The earliest (closest) reflections are at the top of the scale with the 
later ones at the bottom. The total listening time in nanoseconds is called the time range. 

The two most pronounced layers in the data are the direct wave and the road surface reflection. The direct 
wave is the pulse that travels directly from the transmitter to the receiver. It is not a reflection from below 
the antenna. All bistatic (having a separate transmitter and receiver) antennas produce a direct wave. 
Since the positions of the transmitter and receiver are fixed inside the antenna housing, the travel time of 
the pulse between those two elements stays the same. Because of this, you will see the direct wave as a 
horizontal line during data collection. The direct wave is important to collect because it is required in the 
Horn antenna processing software. 

The road surface reflection will be the strongest (brightest) data reflection in the profile. This represents 
the top of the pavement. As you drive along during your survey, this reflection will seem irregular at 
times. This is because the antenna is bouncing around as you are driving. This is normal and Horn 
antenna processing corrects this irregularity. 

Below the road surface reflection you will see other layers in the data. These layers may represent 
pavement layering within the asphalt or even within the base below the asphalt. We will focus more 
closely on them during the data processing and review stage. 

The short vertical white lines at the top of the data window are distance marks. The computer puts them in 
every so many feet (user selectable) to enable you to “eyeball” distance along your survey line. 

Let’s look now at some of the parameters that you will have to work with while collecting data. 
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1.4 GPR System Parameters and What They Mean 

 
Figure 6: Linescan + O-Scope (4105 antenna shown). 

In Figure 5 and Figure 6 you will notice that the vertical scale is in nanoseconds, a measure of time. The 
total amount of time that a GPR will listen for reflections is called the time range. All things being equal, 
a longer time range will allow for deeper scanning. Different antennas have different maximum ranges. 
Usually the lower the frequency, the longer the maximum time range. This is because higher frequency 
antennas lose their power over shorter distances. The goal of setting the time range is to set it long enough 
to go to a desired depth, but short enough so that your antenna power is still adequate to see objects at 
depth For the Horn antennas, time ranges of 8-20 ns are usual. The beginning of the time range is called 
time-zero. 

Samples and Scans 
Your horizontal and vertical resolution is determined by two separate parameters: scans and samples. 
Many people erroneously refer to a GPR profile as a scan. Instead, a profile is built of many, many scans 
all stacked next to each other. Figure 6 is divided into two parts. The part labeled “O-Scope” shows one 
scan. A scan is a combination of all of the reflections from time-zero until the end of your range at one 
point along your survey.  

You decide how often you want to take a scan. Common settings range from 10-12 scans/foot for very 
high resolution, short distance surveys to 1 scan/foot or less for long, network level surveys. At 1 
scan/foot you will only have data every foot. That means if there is a 10 inch long section of anomalously 
thin pavement, and it may not be imaged as clearly as if you had a greater scan density. More scans/foot 
will produce smoother data but will result in larger data files and will require more time to collect, 
meaning that you will have to drive slower. You should set your scans/ft (meter) as low as possible to 
answer your research objectives. This will allow you to survey at the GPR’s maximum possible speed. 
Figure 7 shows three data examples from the same area at differing scan densities. The total linear 
distance is 43 feet. 
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Figure 7: Scan Densities. 

Vertical resolution is affected by your sampling density. Each scan is made up of a number of samples. A 
sample is a record of the strength of the radar reflection (amplitude) at a particular point along the vertical 
range. You can define number of samples per scan during collection setup. The more samples you collect, 
the smoother your scan trace will be. A typical sampling density for pavement layer mapping is 512 
samples per scan. This means that each scan is made up of 512 data points. Scans that are sampled at a 
higher density (more samples per scan) will take longer to collect and will take up more computer storage 
space. Higher scan densities are typically reserved for deep, low frequency geophysical applications such 
as groundwater mapping. 

Filters 
Your GPR system is collecting filtered data. This is done to try to minimize interference from frequencies 
outside of the frequency range of the transmitting antenna. In many places that you will find yourself 
working, the air around you will be virtually filled with electromagnetic radiation that can cause 
interference to your antenna. The sources of this radiation can vary from cellular telephone towers to 
commercial radio and television stations to weather and airport search radars. As a result, we apply filters 
during collection to try to remove this noise. Figure 8 shows data with significant noise. 

There are two types of filters: high pass and low pass. These are useful for removing both high and low 
frequency noise. A high pass filter will attempt to remove any noise which is from a lower frequency than 
the one specified in the filter parameters. Think of it as allowing frequencies higher than the filter 
frequency to “pass by” and get recorded. The low pass works the same way, but it removes frequencies 
higher than the one specified. Noise can also be dealt with in post-processing with a variety of techniques.  

 
Figure 8: Data with EM noise. 
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Typically the filter settings are specific to the frequency of the antenna you are using. The Model 4105 
Horn antenna has a center frequency of approximately 2 GHz. The default low pass filter has a value of 
5000 MHz and the high pass has a value of 250 MHz. It is not recommend that you alter these settings in 
the field during collection. You can always further filter your data later in RADAN but if you set your 
filters incorrectly during collection and filter out too much of your data, you cannot correct that error in 
post-processing. The SIR-20 uses Finite Impulse Response filter (FIR) during data collection. For more 
information on, consult the RADAN Main software manual or Yilmaz (2001). 

If you purchased a Model 4105NR 2GHz antenna with noise reduction filter, you should apply the custom 
filter which came with your antenna on a USB key. This will help to mitigate the noise issue. 

Note: You must collect the data and the antenna calibration file (bumper jump) with the same settings. 

Gain 
GPR data can also be collected with Time-Variable-Gain (TVG). Gain is signal amplification used to 
compensate for the natural effects of signal attenuation. As the transmitted signal passes through a 
material (even air), it will weaken (attenuate) as the material absorbs some signal as well as the normal 
geometric spreading of energy. Gain amplifies that signal after it is received, to compensate for signal 
losses and makes weaker reflectors easier to see. No additional energy is sent out of the antenna.  

The Gain function operates at a number of linearly distributed points along the time range. The Auto Gain 
Servo automatically sets the gain of the system based upon the received signal from the antenna at the 
point where the antenna is located when the servo is enabled.  

In either case, you should leave the system set to auto gain. You cannot set the exact time of a gain point; 
however, you can manipulate the number of gain points so as to ‘position’ a gain point near a particular 
time range (or a particular reflector). You can then adjust the amount of gain applied. RoadScan data is 
collected with 1 point of gain. If you choose not to use Auto gain, be careful not to apply too much gain. 
This will lead to a phenomenon known as ‘clipping’. Clipping occurs when the returned signal exceeds 
the GPR sampler’s maximum recordable amplitude value. As a result, the signal is “clipped” at the 
maximum. Clipping will limit the data and will cause you to lose valuable information and make it much 
more difficult to identify targets in the data. An example of clipping is shown in Figure 9. The areas 
inside of the blue circles show areas where the signal has run off of the scale. 

 
Figure 9: Clipping. 
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Chapter 2: RoadScan System Hardware Setup 
This part of the Handbook covers the physical setup of the RoadScan system components on your survey 
vehicle. Since the variety of vehicles that you could choose to use is very broad, this section is necessarily 
general. This section is divided into three parts: 

1 Attaching the antenna to the vehicle. 

2 Attaching the Distance Measuring Instrument (DMI). 

3 Connecting the SIR-20. 

Take care to disconnect and carefully stow all system components when not in use. This will extend the 
life of your system and avoid damage from environmental factors such as rain. The SIR-20 should be 
packed safely in its transit case whenever it is being transported. 

2.1 Attaching the Antenna to the Vehicle with the Universal 
Trailer Hitch Mount 
One antenna mount available from GSSI is designed to attach to a Class 3 (2” × 2”) trailer hitch. If your 
vehicle does not have a Class 3 trailer hitch, then you will have to engineer some method of securing the 
antenna to your vehicle. Take care to minimize the presence of loose metal parts and attempt to keep all 
metal parts away from the antenna. The steps below are for attaching a mount provided by GSSI. Even if 
you create your own mount, GSSI suggests reading through this next section for ideas. A few other 
customer-designed mounts are shown at the end of this section to help you plan yours. 

 
Figure 10: A Class 3 Hitch (2” square). 
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Steps for Attaching the GSSI Antenna Mount 

1 Attach mount frame. 

Slide the mount frame into the trailer hitch and screw in the safety bolts on each side of the hitch. Then 
tighten the mount locking bolt on the front of the mount frame with a 1 ¼ inch socket wrench (Figure 11). 
The sliding wedge will expand to secure itself in the trailer hitch. 

 
Figure 11: Attach mount frame. 

2 Attach fiberglass rails to antenna. 

Attach the fiberglass rails to the antenna using the eight (8) nylon bolts that came with your antenna. Be 
sure to only hand-tighten these, do not use a wrench. Make sure to position the antenna in the correct 
direction. If you look at the connector on the top of the antenna, you will see 5 key cutouts in the 
connector. The single, large one should point toward the vehicle. Next find the fiberglass rail spacer 
support that will be attached to the mount frame with plastic zip ties. Attach that to the rails with the eye 
bolts that were provided with your mount kit (Figure 12). 

 
Figure 12: Attach rails. 
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3 Attach antenna to mount frame. 

With the antenna on the ground, push the rails back until they touch the mount frame. Notice which bolt 
hole they line up with and measure 18” (50 cm) up on the frame. Take note of which bolt hole is closest 
to 18” (50 cm). Attach the gussets that came with your antenna to the rails. You may find it easier to 
attach the antenna assembly to the mount frame with the top bolt and then pivoting the assembly up to 
attach the others (Figure 13). Measure the distance from the bottom of the antenna to the ground surface. 
It should be near 18” (50 cm). If it is a little less, that is fine because the antenna straps that we will attach 
in the next step will slightly raise the antenna height. 

 
Figure 13: Attach antenna assembly to mount frame. 

4 Attach the antenna straps. 

Locate a secure attachment point on your vehicle for the four (4) ratchet straps. These straps will prevent 
unnecessary antenna bounce while you are driving. Position the attachment points so that two straps 
should exert upward force and two should exert downward force. You can attach the straps to the eye 
bolts on the antenna rail spacer (Figure 14). Make sure that the antenna height is approximately 18” if 
measured from the ground to the antenna bottom. Take care to not over-tighten the straps as this will 
cause the antenna to pitch out of level. 

 
Figure 14: Attach straps. 

5 Attach the control cable. 

Attach the control cable to the antenna connector and run the cable along the rails back toward the 
vehicle. Loose cables will cause noise in the data, so be sure to secure your cable to the rails with tape or 
ties (Figure 15). 
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Figure 15: Attach control cable. 

2.2 Attaching the DMI 
GSSI provides the Model 630B High Resolution Distance Measuring Instrument (DMI) with the 
RoadScan system. The 630B represents the state-of-the-art in high-speed, high-accuracy survey control. 
The DMI comes in a black, plastic transit case that contains the following parts  
(Figure 16): 

 
Figure 16: DMI kit parts. 

(1) Encoder assembly with attached cable and connector to control unit. 
(1)  Mounting plate for attaching the encoder assembly to the wheel. 
(3)  Centering stars used for correctly centering the mounting plate. 
(1)  Short encoder bolt. 
(1)  Long encoder bolt and black plastic spacer. 
(2)  Extension arms (1 long, 1 short). 
(1)  Body mount with suction cups and safety line. 
(1)  Hex wrench. 
(3-5)  Collets. Depending on the number of lug nuts on your vehicle, you ordered from 3-5 
mounting collets. Your collets will also include a bolt and washer screwed into the top of them. 
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Assembly and Attaching the DMI to the Vehicle 
The 630B is designed to be used on the rear wheel of a vehicle. Do not attempt to mount the 
630B on the front wheel of the vehicle.  
1 Prepare the wheel. 

Remove any hubcaps or other covering from the wheel. You will need access to the lug nuts. 

2 Attach the collets. 

Remove the bolt and washer from the collets and then firmly seat collets on top of lug nuts. It may be 
necessary to use a rubber or wooden mallet to ensure a tight fit. If you have more than 5 lug nuts, make 
sure that the collets are evenly distributed. For example, if you have 6 lug nuts and 3 collets, you should 
place a collet on every other nut.  

 
Figure 17: Attach collets. 

3 Place mounting plate on collets. 

Find the black metal mounting plate. Place the plate against the collects so that the raised part of the 
center hub faces you. Loosely screw one of the bolts with the washer into the “First Collet” vertical 
cutout. Now loosely screw the other bolts into the collets using the appropriate vertical cutouts. 

 
Figure 18: Mounting plate with first collet location. 
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4 Center mounting plate on collets. 

Find the Centering Star with the same number of points as the number of collets you have. Position it on 
the mounting plate and spin it clockwise. It will ensure that the mounting plate is properly centered on the 
wheel. Tighten the collet bolts with the Hex wrench (Figure 19). 

 

 

 

 

 

 

 
 

Figure 19: Attach mounting plate. 

5 Attaching the encoder assembly. 

Decide if you need to use the short encoder bolt or the long one with the spacer. If you have a wheel 
which is deeply inset, or overhanging body panel, you may want the longer bolt. GSSI uses a Freightliner 
van and uses the long bolt. Run the bolt through the encoder assembly and then through the spacer (if 
needed) and then screw into the center of the mounting plate. Tighten securely (Figure 20).  

 
Figure 20: Attach the encoder assembly. 

6 Attaching the extension arms. 

The 630B comes with three extension arms to add to the body mount. Decide which combination you 
need in order to place the body mount at a proper height on the vehicle. Bear in mind that the body mount 
should be affixed to a flat, vertical surface. Screw the proper extension arm into the encoder assembly and 
then screw the other end into the body mount arm. Connection points are noted in the picture at the right 
with blue circles.  
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Figure 21: Extension arms. 

7 Attaching the body mount. 

Find a flat spot on a body panel directly above the encoder assembly. Make sure that the location is clean 
and dry. Moistening the suction cups will provide better adhesion. Firmly press the body mount suction 
cups against vehicle and flip the locking switches on the cups to secure (Figure 22). Find some way to 
attach the safety strap clip to the vehicle (roof rack, bed tie down, door handle, etc). 

 
Figure 22: Attach body mount. 

8 Secure cable. 

Run the data cable from the encoder assembly to the survey wheel input on the SIR-20 control unit. Be 
sure to attach the cable in such a way that it is secure and will not get caught on anything or drag on the 
ground. Having the cable catch on the wheel or other object while the vehicle is in motion will likely 
cause enormous damage to the 630B and the GPR control unit. 
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Figure 23: Secure the DMI cable. 
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2.3 Connecting to the SIR-20 
Some users will separate their ToughBook control laptop computer from the SIR-20’s blue control box 
and mount them separately. The blue control box could be in the rear of the vehicle and the control laptop 
could be in the cab. Other users prefer to keep the computer mounted on the blue control box. Either way, 
you will still need to perform the connections in Part 2.3. 

 
Figure 24: The SIR-20. 

Identify SIR-20 Connectors 

1 Attach the antenna control cable to the Transducer 1 connector. You will see a red line around the 
collar of the connector on the SIR-20. Cinch down the control cable collar until the red line is 
covered. This will ensure a good connection. Be careful to only hand tighten all connections. 
Never use a wrench to tighten anything on the SIR-20.  

2 Attach the lead from the DMI to the Survey port on the back of the blue MF-20 Mainframe. It is 
the only 4-pin connector on the back of the system. 

3 Attach your power supply connector to one of the power ports. Make sure all SIR-20 connectors 
are snugged down tightly. 

 
Figure 25: SIR-20 Connectors. 
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2.4 Alternative Antenna Mounts 
This section presents some alternative vehicle antenna mounts. This information is provided to aid you in 
creating an antenna mount for a different vehicle type or for front-mounting the antenna. GSSI does not 
provide materials or support for any of the mounts pictured here. Furthermore, GSSI does not have 
technical drawings or specifications for any of the mounts shown here. 

Arizona Department of Transportation (ADOT) 
This mount was designed and built by the Arizona Department of Transportation to mount on their 
Falling Weight Deflectometer (FWD) vehicle purchased from Foundation Mechanics, Inc. Since the 
FWD apparatus is mounted to the rear of the vehicle, the GPR system needed to be front mounted. GSSI 
would like to thank Arizona Department of Transportation for the images. If you would like additional 
information about this mounting system, contact: 
Gary Sanati 
Foundation Mechanics 
421 East El Segundo Blvd. 
El Segundo, CA  90245 
Phone: 310-322-1920 
gsanati@jilsfwd.com 
www.jilsfwd.com  
 

 
Figure 26: ADOT’s front mount. 
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Figure 27: ADOT’s front mount. 

Antenna Mount without a Class 3 Hitch or Straps 
These photos come courtesy of GSSI’s French representative, MDS. The large gussets are made from 
fiberglass and provide the necessary rigidity to the mount in place of ratchet straps. 

 
Figure 28: MDS mount, rear view. 

 
Figure 29: MDS mount, side view. 
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Chapter 3: Collecting Data 
This section takes you through a step by step sequence for data collection. It is recommended that you 
completely read through this whole part before beginning. It is divided into four (4) sections. 

1 New Project Setup 

2 Setting the Correct Parameters 

3 Collecting a “Bumper Jump” calibration file 

4 Collecting Data: Tips and Pitfalls 

3.1 New Project Setup 
Connect all antenna and survey wheel cables and ensure a good power supply for your SIR-20. Make sure 
that the battery charge indicator light on the Laptop is illuminated. Turn on your system by turning on the 
laptop. After a few moments, your laptop will boot up to the Windows desktop. At this point, you should 
make sure that the cooling fan on the SIR-20’s blue box is running. If it is silent, check the Ethernet 
connection. 

You can also open an existing project and then go to File>Save As and change the name. The new project 
will have the same settings, including the macro, that the parent project had. 

Create Folders 
The SIR-20 is capable of collecting an enormous volume of data. The first important task of the GPR user 
is to find some way to keep this data organized. The SIR-20 uses the hard disk of the laptop computer to 
store data. Before beginning each project, you may wish to create a new folder on the laptop’s hard disk. 
This folder can have any name associated with it, so you can name it by date, customer name, or job 
number.  

Creating a new folder in Windows is easy; just follow the following steps: 
1 Click the Start button on the Windows toolbar at the bottom of the screen. This will open a big 

pop-up menu. 

2 Find the option for “My Computer” and click it. This will open a window showing any disk 
drives installed. 

3 Find the “Hard Disk Drives” section and double-click “Local Disk (C:).” This will open a 
window showing all of the folders that you have stored. You will see six choices at the top of the 
screen. They say: FILE, EDIT, VIEW, FAVORITES, TOOLS, and HELP. Click on File. 

4 Move the arrow down to New and then over to FOLDER. Click on Folder. You will see that 
Windows creates a new folder on your C: drive. You will need to rename this. 

5 Type in a new name and press Enter on the keyboard. 

6 Double-click the little picture of the folder that you just made to go inside it. Repeat steps 4 and 5 
to create a new folder inside of the one you are in. Call this one “Output.” We will look at why 
you need an output folder later. 
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7 Now you are done. Go back to the Desktop and double-click the SIR-20 icon. This will open the 
SIR-20 program.  

Note: You will see a RADAN splash screen when you open the SIR-20. This is because the SIR-20 
program is a module that runs in RADAN. Click anywhere on the screen to make the image disappear. 

Set Program Defaults 
Now you will need to tell RADAN about the folders you created and set some other parameters. We will 
start from the initial RADAN/SIR-20 screen. 

 
Figure 30: SIR-20 initial screen. 

1 Find the View pull-down menu at the top of the screen and click on it. Look for the Status Bar 
and the Customize options. 

2 Make sure that there is a check next to the Status Bar. If not, move the arrow down to highlight it 
and click on it. 

3 Next click Customize. You will see a window with four tabs at the top. 

 
Figure 31: Customize window. 

4 Set Working Directories.  

5 Click the Source button. You will see a window pop-up with a list of folders that are on your 
computer. If you type in a new complete path beginning with C:\ then RADAN will also create a 
new folder for you. 
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6 Find the folder that you created in the previous section and click the picture of the little folder to 
open it. Then click OK.  

7 Do the same for the Output folder.  

8 We need to have a Source and an Output folder because the SIR-20 will store different parts of 
your data in different places. It does this so that parts of data that you don’t want to get 
overwritten by accident (like project info files) are protected in the Source folder while the 
system stores other files in the Output (processed data). 

9 Set your viewing preferences under Appearance. This tab controls the look and feel of the 
software. If you like to see Large Buttons on the screen for example, make sure that that choice is 
checked. These changes will take effect the next time that SIR-20/RADAN is started. 

10 Click the Linear Units tab. This sets your units of measurement and the order of magnitude of 
those measurements. Choose whatever you feel is appropriate for your application. 

• If you are using a GPS with your system, click the SIRVEYOR tab to configure the GPS. 
Instructions on this can be found in the GPS integration chapter of the SIR-20 manual. 

11 Click OK once you are satisfied that you have set up the system to your desired parameters. 

Create New Project 
The SIR-20 collects data with a project file system. The Project file allows you to define settings for the 
whole data collection project and then collect a series of data files with some common settings. 

1 Create a new collection project by going to File>New or clicking the New Project button  on 
the collection controls bar. This will open a window with the heading Create New Data 
Collection Project (Figure 32). Enter a project file name in the white box that is labeled “File 
Name.” Remember to keep the name to not more than 8 characters because the name will be 
cropped after the eighth character. Alphanumeric values are acceptable. Do not use any symbols.  

• RoadScan data is collected as a 2D file. 

 
Figure 32: Project File Name box. 
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2 Click Next >. This will open a new window with the heading Review Project Information 
(Figure 33). 

 

Figure 33: Project Information dialog box. 

3 Enter information to describe your project area. You can give the project a Title, Start/Finish time 
and add Notes.  

• Note the gray button for Output Path. This is the location where the SIR-20 will store your 
data files. This location was set by you in View > Customize.  

• All data entry on this screen is optional. If you do not wish to add notes, click Next >. A 
window will open with the heading Data Collection Mode (Figure 34). 

4 This window allows you to select and calibrate your DMI (Survey Wheel) and to select the 
RoadDoctor CAM Link software output.  

• RoadDoctor is a third party software package that supports video data collection and 
integration. The CAM link output sends the GPR scan number out through the laptop’s 
parallel port. Contact sales@geophysical.com for additional information about RoadDoctor. 
Notice the button for Enable GPS. You can collect GPS data along with your survey wheel, 
data. See the section in the SIR-20 Manual on using a GPS for details on setup.  

5 Click Survey Wheel, you will see a button for Calibrate SW. Click on it. 

mailto:sales@geophysical.com
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Figure 34: Data Collection Mode window. 

6 You will see a window pop up with the heading Survey Wheel Calibration (Figure 35). This is 
where you enable the DMI and calibrate it to accurately track distance. You must calibrate your 
survey wheel. Failure to do so will result in an incorrect horizontal scale on your profiles. 
Note:  DMI = Survey Wheel. 

• Calibrate your survey wheel by laying out a long distance with your tape measure. It 
should be at least 50 feet (20 meters). Enter the distance in the “Calibration Distance” 
window and inch the vehicle forward so that the front wheel is at that start of the tape. Click 
Calibrate and drive to the end of that distance. Note that the number of ticks increases. 

 
Figure 35: Survey Wheel Calibration dialog box. 

7 When you have gone the full distance click Save > Next >. This will open a window with the 
heading Configuration (Figure 36).  

8 This window allows you to set some collection parameters. GSSI has created a number of  
pre-loaded setups for road scanning.  

• Click on the Config Type pull down window and select HIGHWAY.  

• Next go to the Config Name pull down and select H1.0 GHz or H2.0Ghz. You will need to 
decide on a scan density.  
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• If you are doing a short distance, high resolution survey, you may want more scans/ft (m) in 
order to resolve small changes in thickness along your survey line.  

• If you are collecting tens of miles, then 1 scan/ft is a good compromise between data density 
and speed.  

 
Figure 36: Configuration Window. 

9 Once you have decided on a scan density, click Next to open the Macro window  
(Figure 37).  

 
Figure 37: Attach a Macro or Create a New One. 

• This window will ask you to either create a new macro, or attach one that you have already 
created. This macro is nothing more than a saved list of data collection parameters. These 
parameters include: filters, time range and gain settings. These parameters may vary from job 
to job, so it is possible that you will have many different macros for different survey 
objectives. Common parameters for your antenna will be selected automatically based on the 
Config Type and Config Name that you chose in Step 5. 

• There are no pre-saved macros on the system, so if you are using your SIR-20 for the first 
time you will need to create one. Click the button for Create New Macro and click Finish. 
The antenna will initialize, you will see a clock counting a few seconds and then data will 
scroll across the screen. 

• Your basic project setup is complete. You will now set the correct parameters for data 
collection in the next section. 
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3.2 Setting the Correct Parameters 
After following the steps in the previous section, you will see this window (Figure 38). 

 
Figure 38: Data collection setup window. 

You will need to make a few adjustments before beginning collection. Follow the steps below. 
1 Configure Position. 

Click on the left most blue and yellow button. If you hover over it with your cursor, it will say 
Position/Range. You will need to adjust the time range so that you can see the direct wave and the ground 
surface reflection. Uncheck the box for “Auto Position Servo” and click Apply. Next, adjust the position 
manually by typing a number into the position box and clicking Apply. It should be approximately  
96.5 ns, but compare the image to Figure 41. Figure 39 shows the scan trace with the position set too low. 
Figure 40 shows the position too high, and Figure 41 shows the proper setting. 

 
Figure 39: Position too low, direct wave is not present. 
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Figure 40: Position set too high, too much trace before the direct wave is present. 

 
Figure 41: Correct position setting. Direct wave and ground surface wave shown. 

2 Check Gain. 

Click on the second blue and yellow button to bring up the Range Gain window. Make sure that the 
“Number of Points” is set to 1 and that the signal is not more than 50% of the height of the window. If it 
is, then put a lower number in the Value window and click “Apply.” You should make sure that the box 
for “Auto Gain Servo” remains checked in order for the Auto Gain to properly set a value. Be sure that 
the area underneath the antenna is pavement. Click close. 
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Figure 42: Check Gain. 

3 Check Filters.  

RoadScan data is collected with some frequency filters designed to help minimize noise. Click on the 
forth blue and yellow button (FIR Filters) to check the Low Pass and High Pass frequency filters. The 
4105’s correct filter settings are 5000 for the Low Pass and 250 for the High Pass. The 4108’s settings are 
3000 for the Low Pass and 250 for the High Pass. Save the settings by clicking on the Save Macro button. 

 

 
Figure 43: Filters. 
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Applying the 4105NR Filter 
The 4105NR contains a noise reduction filter that has been custom designed for your individual antenna. 
Be sure to load the filter information onto your SIR-20 before attempting to apply the filter. The filer 
information can be found on the USB drive which was provided with your 4105NR. To load the filter, 
plug in the drive and follow the onscreen instruction. 

a) Once the “stopwatch” finishes and the antenna has initialized, you will need to apply 
the custom FIR filter. Click on the FIR filter button, , or select Process>FIR 
Filter. You will see the window in Figure 44. 

b) Check the Custom box and then select the filter which corresponds to your 4105NR’s 
serial number.  

c) Click Apply and then Close.  
• Be sure to apply the filter at the beginning of your collection, especially before 

collecting the metal plate calibration file. Double check the position to make sure it is 
still correct. 

d) Select the IIR filter button , and enter in a value of 10 MHz in the Vertical High 
Pass. 

 
Figure 44:FIR filter selection window. 

4 Start Collecting.  

Click the green arrow at the bottom of the screen to begin collection. When finished with the data 
collection, click on the red square with the white dot in the center to stop data collection and save the file. 
To collect another data file with the same settings, click on the green square to initialize the antenna and 
then click on the green arrow to begin collection. 

Note: There can be a lag time of several seconds between clicking the green collect arrow and when the 
SIR-20 is ready to begin receiving data. Be sure to plan for this lag time. 

Helpful Hint: You will want to make a note of any visible changes in asphalt color or condition 
while you are surveying. Each time you see a change or location that you wish to note in the data, you can 
click the down arrow key on the keyboard to put a user mark in the data. 
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Working with the Master Project File (Optional) 
The SIR-20 incorporates a “Master Project” collection scheme that is intended to streamline data 
collection. It is intended for use in application where all data area collected with common settings. The 
master project is created by you just like any other project, but it is saved into the Master Project file in 
the SIR-20 program. It is then automatically recalled at the beginning of each collection. Upon recalling 
the master project, you will have the opportunity to change its name. This will not re-name the master 
project file, but will become the root name of all of the data files that you collect going forward.  

To use: 

1 Create a data collection project as described in the previous section. Take note of the location 
where that project is saved. 

2 Minimize or close the SIR-20 collection program and copy that project file and the macro to: 
C:\Program File\GSSI\RADANXP\Master Project. Make sure the macro copies as well. For 
example, if you called your project TEST, you will need to copy TEST.RPJ (project file) and 
TEST.CMF (macro) to the master project file. You can rename it at this point if you wish, but 
make sure both files have exactly the same name. 

3 When you wish to use the master project, open the SIR-20 collection program and click the Run 

Master Project icon located at the bottom-left of the screen.  

4 Enter in a new name if you wish. The data files will be saved to the working directory. 

5 Collect data as normal. 

3.3 Collecting a “Bumper Jump” Antenna Calibration File 
The Bumper Jump Antenna Calibration file (.CZT) is crucial to Horn antenna processing. You should 
collect a Bumper Jump file at the beginning of each day’s data collection. GSSI recommends collecting 
an additional one at the end of the day as well. 

1 Place the metal plate directly underneath the antenna. 

2 Open the data collection project that you are working on. You set up this project in Parts 3.1 and 
3.2. In SIR-20, go to File>Open and change the Files of Type to Project Files. Select the project 
and click open. 

3 Find the Project menu at the top of the screen and go to Antenna Calibration. 

 
Figure 45: Configuration Window. 
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4 Jump up and down on the vehicle’s bumper to collect the full range of motion for the vehicle’s 
shocks (Figure 46). You will collect about 15 seconds of data. The resulting file should look like 
the one in Figure 47. After about 15 seconds, click on the red box with the white dot to stop and 
save the data file. It will be saved in your output directory with the extension .DZT. 

 
Figure 46: The Jump. 

 
Figure 47: Raw Calibration File. 

5 Make sure to write down the filename of your raw calibration file so that you can find it when it 
comes time to do the post-processing. You can now click on the green square to collect more road 
data. The SIR-20 will automatically go back to survey wheel collection. 

Note: The antenna calibration file must be collected with exactly the same settings (time range, filters) 
as your data file (IMPORTANT). 
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3.4 Data Collection Tips 
This section presents some tips and troubleshooting information that you may find useful during 
collection. 

• Make sure the sound on your laptop is turned on. The Laptop will emit a beep if you are 
collecting data too fast. This is called over-speeding the antenna and can result in confusing or 
incorrect results. 

• If you see a “Local Area Network” lost message at the bottom right-hand corner of the screen, the 
SIR-20 is no longer communicating with the laptop and you are not taking data. Possible causes 
are a loose Ethernet cable between the laptop and the blue box of the SIR-20, or that the SIR-20 
has lost power. 

• Keep a tarp or a plastic bag with you to cover the antenna in case of wet weather. The antenna is 
not waterproof. 

• Hang a bright red or orange flag from the antenna to warn other drivers, or have another vehicle 
drive along behind the survey vehicle. 

• Take good notes. Keep a survey logbook and record everything of interest to the survey. Take 
photos and make note of data file names. 
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Chapter 4: Data Processing with RADAN and 
the Road Structure Assessment Module 

The Road Structure Assessment Module (RSA) in RADAN is a specialized data processing tool used to 
assess thickness (depth) and physical characteristics of multiple road layers. The RSA module can be used 
to process data obtained with GSSI SIR Systems using the 1 GHz (Model 4108) and 2 GHz (Model 4105) 
horn antennas. It is suitable for all types of roads as well as airport runways and taxiways. Typically, a 
road structure consists of a wearing course, base and sub-base; these three layers or their equivalent can 
be analyzed. 

This module enables fast analysis of large data sets collected from a survey vehicle over miles of road 
surface. The layer characteristics may be automatically calculated using antenna calibration data and are 
used in processing for accurate assessment of layer thickness. 

The module consists of three main processing steps: 

1. The Reflection Picking procedure eliminates unwanted noise, detects significant reflections and 
records the corresponding time and depth. It uses antenna calibration file data to calculate the radar 
signal velocity within the pavement. 

2. The EZ Tracker Layer Interpretation procedure uses the output from the first step to map structural 
layers and calculate the corresponding velocities and depths. Certain criteria defined by the operator 
are used for both steps.  

3. The results can be visually examined in Interactive Interpretation mode and adjusted if necessary. 
The output files from each step (*.RFP and *.LAY) are in ASCII format and can be easily input into 
spreadsheets such as Microsoft EXCEL for further processing or input into an image mapping 
package such as Golden Software’s SURFER. 

In order for the Horn antenna processing to work effectively, you must first generate a calibration file 
from your raw bumper jump data file. 

4.1 Calibration File Generation 
The raw antenna calibration file is obtained by placing a metal plate underneath the antennas and 
collecting data with the antennas first stationary and then bouncing up and down (to simulate the antenna 
height change when the vehicle runs over a bump or pot hole). The process of collecting a calibration file 
is described in detail in Part 3.3. 

Each raw calibration file (*.dzt) is processed using the Calibration file generation tool in RADAN. The 
default extension on the output from the Calibration Tool is *.czt. The calibration generation tool 
reorganizes input data scans, performs some scan stacking, and overwrites the last 6 samples of each 
output scan with specific amplitude and height information.  

Note: Never edit or apply any filtering to the .CZT file. 

The following sections describe how to access the Calibration File Generation Tool and what options 
need to be set in the tool dialog. You will use the RADAN software on your SIR-20 or on a separate 
processing computer to do the following steps. 
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1 Accessing the Calibration File Generation tool. 

Open the raw antenna calibration file (*.dzt). Select Process menu (Infrastructure submenu)>Generate 
Calibration File or click  on the RADAN toolbar. 

2 Setting the Dialog Options. 

After clicking the Calibration File Generation process button, you will see the window shown in Figure 
48. There are a few things we need to do here. The information shown on the dialog is stored with the 
processed data file header and is accessed when the calibration file is used in the reflection picking tool. 
The parameters selected in the dialog determine how the data file is processed in reflection picking.  

Each one of the parameters in the Calibration File Generation Dialog is discussed below. 

 
Figure 48: Calibration File Generation dialog. 

Antenna Config: This is the antenna setup for data collection. RSA Profile must be selected in the 
Antenna Configuration dialog box. The other option “RadBridge Project” is used with the Bridge 
Assessment module. 

Use Air Wave File: The air wave file is optional and normally not used. Check this box if an air wave 
file has been collected. Then enter the air wave filename in the space to the right. The airwave file is most 
commonly collected by turning the antennas upside down so that they radiate upward. This file is 
obtained using the same SIR-10/20 settings as the metal plate calibration file.  

Antenna Type: Select the antenna used for data collection. There is a choice of the Model 4205, 
Model 4208, Model 4108, Model 4105HR or Model 4108HR antennas. The “HR” options implement an 
algorithm designed to improve thickness measurement accuracy for pavements 6” (10 cm) or less in 
thickness. Choose 4105HR for the 2 GHz and 4108HR for the 1 GHz. 

Once all of the parameters are set in the Calibration Menu, click OK to begin execution. A typical *.CZT 
output file for the 2 GHz horn antenna is shown in Figure 49. It is a good idea to save the .CZT file with 
an easily remembered name to be able to quickly identify it during processing. RADAN also has a special 
folder called Horn Cal. If you like, you can save your CZT file to that folder. When you run the 
Reflection Picking process in the next step, RADAN will ask if you would like to search for a CZT file in 
this folder. It may help to keep things organized. 



Geophysical Survey Systems, Inc. GPR Inspection of Road Structures 
  

MN43-183 Rev H 43 

 
Figure 49: Typical processed 2 GHz horn antenna calibration file (*.CZT). 

Each processed calibration file contains up to 33 scans. 

4.2 Processing a Survey 
This section takes you through the processing sequence for long distance surveys. There is a refinement 
for short surveys that may be required for FWD modeling. That refinement is discussed in Part 4.3. 

Quick Overview of the Processing Sequence 
Processing road data requires you to go through three steps: 

1. Reflection Picking Process - locates the significant reflection events in the data and records this 
information into an ASCII file. 

2. Layer Tracking in Interactive Interpretation- uses the output from reflection picking to help you 
interactively find and track layers in the data.  

3. Data Output as an ASCII .CSV spreadsheet-compatible file. It will have the extension .LAY. 

Once the processing sequence is completed, the pavement engineer can take the numerical output of 
pavement thicknesses and run descriptive statistics in Excel or add the information to a pavement 
database with third-party software. 

Step by Step Instructions 
Before beginning your survey processing, you must have created an antenna calibration file as described 
in Part 4.1. 

1 Open the survey data file and add display gain if necessary. Display gain can be added by right-
clicking on the actual GPR data and selecting a gain value from the display gain pop-up window. 
This will not permanently alter your data, it will simply make things easier to see. 
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2   Click on the Horn Reflection Picking icon, or under Process>Infrastructure>Horn 
Reflection Picking. This process will do the following items automatically. 

• Eliminates unwanted signals from the radar data, so the signals from the pavement layers are 
clearer and easier to track. 

• Tracks the reflections from the bottoms of the various layers comprising the pavement. 

• Measures the return times of the reflections and calculates the two-way travel time for each of 
the pavement layers from the data. 

3 After clicking the icon, you will see a window like the one in Figure 49. The process will prompt 
you to specify an antenna calibration file. This is the file that you created in Part 4.1. 

Auto Load Calibration File: RADAN will search for a CZT file in the Current folder selection. This 
selection will be either the current output folder you selected in View>Customize, or the Horn Cal folder 
in the RADAN program directory. If RADAN finds a CZT file, you will see it displayed in the 
Calibration File window. If you have more then one CZT in the particular, RADAN will select the first 
one in alphanumeric order. 

Check to make sure that the calibration file displayed is correct and then most users can just click Finish. 
Save the file with a unique name. The automatic mode of the processing will work just fine for most 
people. For advanced users looking to have more control over this process, uncheck the box for 
Automatic Mode, and then click Next. You will see a window like the one in Figure 50. 

 
Figure 50: Reflection Picking 
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Figure 51: Reflection Picking Window. 

Selection Options 
Layer 1: The option for locating significant reflection events in scans, within the defined depth range for 
the top layer (usually the pavement). This option must be activated in order to perform any reflection 
picking in the scan. 

Layer 2: The option for locating significant reflection events in data scans, within the defined thickness 
range for the second layer.  

Layer 3: The option for locating significant reflection events in data scans, within the defined thickness 
range for the third layer.  

Each layer has three associated parameters that can be modified.  

• Thickness Range: The Min and Max expected pavement layer thickness values. The default 
Min and Max values are 0.05 to 0.2 m (2-8") for the first layer, 0 to 0.3 m (0-12") for the 
second and 0 to 0.5 m (0-20") for the third layer. It is important to note that up to seven layers 
may be identified however, at this stage of the processing we are identifying reflections that 
can be used to create layers and not the layers themselves. 

• Threshold Level (dB): This is the minimum strength for a reflection to be considered 
significant enough that it is recorded. The default is -39.99 decibels (dB). The reflection 
threshold level is approximately equivalent to 20*log10 (Pavement Reflection Amp/ 
Calibration Plate Amp). 

• Polarity Criteria: Define the polarity of the reflection events picked between the user-
selected minimum and maximum pavement thickness values. The options are positive, 
negative or both. Commonly the propagation velocity decreases for deeper layers. This 
results in a positive polarity reflection at the layer interfaces. Positive polarity is the default 
option for all layers. If you see that your layer is a prominent negative return, then you should 
choose negative for this option for that particular layer. 

Ringdown Removal Filter: This filter eliminates horizontal features such as ringing in the data that 
possess amplitudes less than the reflection picking threshold level. Therefore, the characteristics of the 
filter change based on the reflection threshold level. (The reflection picking threshold level option is 
located in the following dialog). It operates in a manner similar to a horizontal average subtraction filter; 
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when activated, it operates from the depth range between the maximum pavement thickness to the bottom 
of the scan. The Ringdown Removal Filter box should always be checked. 

Calibration Plate Scan Subtraction: Performed to remove coherent clutter in the data. For the horn 
antennas, the calibration file contains a series of calibration plate scans obtained over a range of antenna 
heights above a metal plate. The calibration scan obtained at the height most closely matching the data 
scan is selected. The peak amplitude of the calibration plate scan is then normalized relative to the peak 
amplitude of the data scan and subtracted from the data scan, starting at the peak of the pavement 
reflection and continuing downward to the bottom of the scan. The Calibration Scan Subtraction box 
should always be checked. 

Although this window allows you to further tweak the Horn Processing algorithm, the default settings are 
usually fine. Click Next. The next window will inform you of the display color and size of the individual 
layer picks that will flash across the screen. Change these if you wish, or simply click finish. The data file 
will scroll rapidly and it will prompt you to save the new, processed file. Give the file a unique name and 
click Save. You will see an image like Figure 52. Remember to add display gain. Note that in the 
processed data file, the pavement surface is now flat and Time-Zero is now at the pavement surface. 

 
Figure 52: Horn Reflection Picking Output, Display Gain added. 

4  Click on the Interactive Interpretation icon or View>Interactive. This will bring up a 
window that will prompt you to open a previously saved Interactive Interpretation pick file or to 
click OK to create a new one. Click OK and the data will open in a split screen like the one 
shown in Figure 53. The top pane is your GPR data with the vertical scale in time (ns). The 
bottom pane will display your interactive picks against a depth scale. 

 
Figure 53: The Interactive Interpretation Interface. 
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Important Note: If this is the first time that you have used this feature in RADAN, you should 
right-click on the radar data and go to Layer Options. In Layer Options, click on the Properties tab and 
change the Layer Velocity Calculation Method to “Automatic.” Click Apply and then OK. This will allow 
the Horn Antenna Processing algorithm to calculate the correct radar wave velocity in the pavement for 
you. This will result in more accurate layer thickness information. Once you make this change, it will be 
saved in the RADAN user parameter file and will be preserved. 

You will use EZ Tracker to track your layers in the data. EZ Tracker allows you to click on a layer in the 
data and then click on it again further down the profile. EZ Tracker will then “connect the dots” using the 
interpolation technique specified in the Layer Options, Properties menu (Nearest Peak or Linear). Select 
the current layer and click Start. Left-click once on the layer and EZ Tracker will put in a colored dot in 
that location at the maximum amplitude and polarity as specified for that layer in the Layer Options, 
Properties Tab . Note that the search width for identifying the points is defined by the Search Width 
parameter. It may be set as either 1, 3, 5, 9 or 17 scans (Figure 54). 

 
Figure 54: EZ Tracker interface. 

Keep clicking on the layer as you follow it though the profile. EZ Tracker will fill in the blanks. If it skips 
to a different layer or if you make an error, right-click to erase all of the picks back to the previous one. 
You will want to click Save every so often to save your work. Once you are finished with the layer, click 
Stop and change the Current Focus to the next layer if applicable. 

 
Figure 55: Pick Options. 

If you need to edit your picks, close the EZ Tracker window so that the Pick Options window is left open 
(Figure 55). If you set the picking tool to Single Point, this will allow you to right-click on pick and delete 
them one at a time. You can also left click on the layer and it will add picks one at a time. In Single Point 
mode, you will specify a search width of a certain number of scans. This will appear as a cursor that looks 
like a pair of short vertical lines on the data. RADAN will choose the most appropriate point given your 
picking criteria that falls between that search width.  
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Another option is to change the picking tool to define a block or a range. With the Select Block tool, you 
will be able to reshape a block to fit around an area. Once you have reshaped your block, right-click on 
the block and select “add points.” RADAN will trace the layer through the block. You may also select a 
block that covers a gap in the picked layer. If you have points on one side of the block and the other but 
not in the middle, this will allow you to interpolate a computer “guess” in between. This is done 
sometimes when the layer in the data was too weak for the computer to accurately track it initially. Once 
you have your block set up, right-click and select “interpolate points.”  

Select Range will track a layer at the specified time-depth throughout the entire data file. 

Once you are satisfied with the changes, close the Pick Options window, right-click on the data and go to 
Save Changes. 

5 Output.  

Once you have made your picks, you should close the Pick Options window and right-click on the data. 
Go to Save Changes and make sure that your data is saved. The information will be saved in a file with 
the same root name as your radar data file but it will have the extension .LAY. This file is an ASCII file 
that can be imported into Excel. 

Open Microsoft Excel and go to File>Open. Browse to the folder where your .LAY file was stored. 
Change your Files of Type to All Files (*.*) and select the .LAY file that you are looking for. You will 
see the Excel data import window (Figure 56). 

 
Figure 56: Microsoft Excel Importer. 

The data is comma delimited and typically starts at row 12. Follow the steps in Excel to input the data. 
Your data will then show up in Excel with 1 row for every pick. The column headings are: 

FILE: The filename of the processed RADAN format (*.dzt) file. 

CH#: A number denoting the hardware channel used in data collection.  

SCAN#: The scan number relative to the beginning of the data file. The first scan number is always zero. 

X: The scan location relative to the beginning of the data file. The distance of the first scan in the file is 
normally zero. This value can be changed by editing the Local Origin X value in the database Regions 
table. See the RADAN manual for a discussion of the database structure. 

Y: The Y-coordinate of the data point. This value can be user-specified by editing the Local Origin Y 
value in the database Regions table. 
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LAYER #: A number assigned to the desired layer determined by the user-defined layer model. For 
example, if the user specifies a 3-layer model, the top layer in the model is identified as layer 1, the 
middle layer as layer 2, and the bottom layer as layer 3. Layer names can be attached to each layer in 
Interactive Interpretation. 

Z: The depth to the bottom of the layer from the pavement surface in user-defined units. Notice that the 
value is total depth, not thickness. 

AMP: Amplitude of the reflection event. By default, this value is the reflection amplitude normalized 
relative to the predicted amplitude of the reflection from a metal plate positioned at the same depth, in 
units of decibels. Other amplitude units can be selected from the Global Options in the Interactive 
Interpretation main menu which is accessed by right clicking on the data. 

DEV: Deviation of calculated layer bottom depth from a least-squares fit line through points comprising 
the layer over the search window length distance. 

% SCANS: Percentage of scans located within the search window that contain the layer reflection. 

VEL. TYPE: Velocity method used for obtaining layer velocity.  

V: The interval radar propagation velocity assigned to the layer in user-defined units. 

T(NS): The arrival time of the reflection event in nanoseconds with respect to time-zero. 

Note: To get layer thickness of Layer 2, you must subtract the Layer 1 thickness from the Layer 2 Z 
value at that location. 

4.3 Using a Macro to Process Large Amounts of Short Files 
Some applications, such as FWD modeling, will require the collection of many short data files. A macro 
process can then be used to speed up some of the processing steps. A macro is nothing more than a saved 
set of processing steps that can be run on different files. In order to do macro processing, you must first 
create the macro with the steps that you want to automate. For RoadScan data, we automate the Horn 
Reflection Picking step into a macro. You will still need to create an antenna calibration file according to 
the steps in Part 4.1. 

To Create a New Macro File 

1 Open a data file. The data file should be representative of the files that you will want to run the 
macro on. 

2 Select Process > Macro Process > Create. A dialogue box will ask you to enter the name of the 
macro file you will be creating. Enter a name and click Save. If you look at the status bar in the 
lower right-hand corner, you will see the name of the macro displayed there. That indicates that 
all of the steps that you are performing on the open file are being recorded in the macro. 

3 Click the Reflection Picking button from the RADAN toolbar  and enter the calibration file 
and other requested parameters (see Reflection Picking section in Part 4.2). Once all the 
parameters are set, click Finish. The file will not process on the screen, but the parameters are 
being recorded. 

4 Select Process > Macro Process > Close. Now the macro is saved. 
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Note: All processing functions on the toolbar will not be activated until the macro is Closed or you Run 
the macro. For more details on creating a Macro file, refer to the RADAN for Windows manual. 

Loading and Modifying an Existing Macro File 
It is also possible to load and modify an existing Macro Program instead of creating a new file: 

1 Select File > Open to open a RADAN data file. 

2 Select Process > Macro Process > Load. A dialogue box will ask which Macro Program you wish 
to load. Highlight the Macro file (*.cmf) and click OK.  

3 An Edit Macro File dialogue box will appear. If you wish to edit the macro, double click onto any 
function (such as Reflection Picking) and modify its parameters as they appear in the function 
dialogue box. Otherwise, simply click Cancel to exit the dialogue box. 

4 To deactivate a function without deleting it, move the mouse cursor to the little function box in 
the Macro dialogue box, and uncheck the box by clicking on it. Click OK when the modifications 
have been completed.  

The Macro Program is now ready to run. 

Running a Macro File 
Now that you have your macro file created, you can apply it to your data files. You will need to open your 
data files and apply the macro one at a time. 

1 Open a data file. 

2 Load a Macro File before running it.  

3 After selecting OK from the Macro Edit menu, or just after creating the macro, click the Start 
Processing icon . From here, all processing will be automatic and the display will indicate 
that these functions are being applied to the data. 

4 To quit processing, select the Stop Processing  

5 To pause processing, select the Pause . 

6 After the macro is finished and you have saved the processed file, Interactive Interpretation will 
automatically open. 
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4.4 Additional Options 
This section is meant as a reference. It covers some additional functionality that allows you to tweak your 
data but is not strictly necessary to complete the basic RoadScan process functionality. 

Layer Interpretation 
The Layer Interpretation option is designed to help automatically track layers in road structures that 
exhibit clear and consistent layer reflections. The output is identical to the manually derived output of EZ 
Tracker, but under certain controlled conditions LI can bypass that manual step. However, even under the 
most ideal conditions, the output from LI may still require significant manual editing. The Layer 
Interpretation Process is accessed by clicking the  button on the toolbar or by selecting Horn Layer 
Interpretation in the Infrastructure submenu under Process Menu. 

Note: Layer Interpretation can only be performed on files that have been output from the Reflection 
Picking process. 

 
Figure 57: Layer Interpretation Process. 

In the Automatic Mode, just click finish and LI will attempt to locate the specified number of layers. The 
minimum depth allows you to set the search range outside of the ground surface reflection. This is to 
prevent LI from picked the ground surface reflection as a layer by mistake. Automatic Mode works very 
well for clearly visible single layers. It is especially appropriate for picking overall pavement thickness. In 
areas with complex pavement layering or for specialized studies, select Manual Mode and click Next. 
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Figure 58: Layer Interpretation Search Parameters 

Search Parameters  
Layer Continuity Threshold: The minimum distance extent of linked reflections required for the linked 
reflections to be considered a layer. The default setting is 10 meters. 

Number of Output Layers: The anticipated number of layers in the pavement and sub-pavement 
structure (maximum 7). 

Search Window Size: Horizontal: The horizontal dimension of the layer search window. Reflection 
events within the search window are linked together. The default setting is the distance traversed over  
9 scans. 

Search Window Size: Min Vertical: This distance represents the acceptable vertical variation for 
linking two reflection events. The default value is 5cm (2"). 

Slope: The vertical dimension of the search window can be varied with increasing horizontal distance 
from a reflector to improve linking of reflections from dipping layers. The default setting is 
approximately 1cm/m (0.12 in/ft). 

Selection Parameters 

 
Figure 59: Selection Parameters dialog of Layer Interpretation Process. 
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Layer Bottom Depth Min and Max: The minimum and maximum depth criteria for a given layer. 
Reflection events that fall within these depth constraints and meet the layer bottom picking criteria are 
assigned that layer number. 

Layer Bottom Picking Criteria: Determines the type of reflection to consider for an event. There are  
12 different options: 

1. First layer reflection arriving in the depth window 
2. First positive polarity layer reflection arriving in the depth window 
3. First negative polarity layer reflection arriving in the depth window 
4. Maximum positive polarity layer reflection in the depth window 
5. Maximum negative polarity layer reflection in the depth window 
6. Maximum absolute amplitude layer reflection in the depth window 
7. Second layer reflection arriving in the depth window 
8. Second positive polarity layer reflection arriving in the depth window 
9. Second negative polarity layer reflection arriving in the depth window 
10. Second highest amplitude positive polarity layer reflection in the depth window 
11. Second highest amplitude negative polarity layer reflection in the depth window 
12. Second highest absolute amplitude layer reflection in the depth window.  

The different criteria are very useful when multiple linked reflection events are located within the layer 
depth window specified by the user in the Search Parameters Dialog. However, for most cases, the Max 
Pos or Max Neg options will yield the best results. 

 
Figure 60: Display Parameters dialog in Layer Interpretation Process. 

Display Parameters 
Color: The layer-specific colors of the circular markers displayed on top of scans containing specific 
layer picks. The color options include: white, yellow, red, green, brown, gray, and black. 

Size: The size(s), in pixels of the circular markers displayed on top of scans containing specific layer 
picks. The size options range from 0 to 10. A size of 0 will prevent the layer pick from being displayed on 
the computer screen. 

Reflection Pick (color, size): Using this option, reflection events that are not grouped into specific 
layers can be shown in the desired color and size. 
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Velocity Options 
There are two options in this menu for layer velocity selection. The user can choose to have the program 
automatically calculate the layer velocity or enter a known value. 

Calc: When this menu item is selected, the velocity for the specific layer is automatically calculated.  

User-Selected Velocity: This option is not labeled in the menu, but appears as a box just to the right of 
the Calc box when calc is inactive. To activate this box, the user must deselect Calc. Using this option, a 
propagation velocity for the layer can be specified – usually, a velocity can be determined from ground-
truth measurements. It is not necessary to know the velocity during this step in the processing. Core 
depths can be entered to back-calculate the layer velocities in the Interactive Interpretation process. 

 
Figure 61: Velocity Options dialog in Layer Interpretation Process. 

Additional Options in Interactive Interpretation 

Editing the Spreadsheet 
Right-clicking on the data and selecting the Spreadsheet option from the 
Interactive Interpretation main menu brings up the window shown in Figure 62, 
which is an Excel-style spreadsheet containing the current pick information. Each 
row in the spreadsheet shows data from a single pick. Subsequent rows represent 
subsequent picks. All layers and target picks are displayed by default.  

 

 

 
Figure 62: Pop-up spreadsheet containing layer pick information. 



Geophysical Survey Systems, Inc. GPR Inspection of Road Structures 
  

MN43-183 Rev H 55 

By clicking the right mouse button on the Picks column header, a small pop-up menu is invoked. You 
will be able to select a single layer or targets or all picks to be displayed.  

 
Figure 63: Layer selection menu. 

Figure 64 shows the same spreadsheet with only Layer 1 displayed. 

Single picks can be deleted from the spreadsheet and database by clicking on the row numbers to 
highlight a row, then pressing the Delete (Del) key on the computer keyboard. 

 
Figure 64: Single layer display in a spreadsheet. 

 
Figure 65: Spreadsheet rows (picks) selected by clicking on the row number. 

They can be deleted using the delete key on the keyboard. 
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Adding Ground Truth 
If you have core data and can measure the thickness of a layer at a given location, you can input that 
information and calculate layer velocities (Figure 66). 

 
Figure 66: Spreadsheet showing options for ground truth points. 

Ground truth data can be entered on the left half of the spreadsheet and the calculated velocity and nearest 
scan location are automatically updated and shown in the right side of the spreadsheet. 

For example, let’s say a core was drilled 104.5 m from the starting location of the file and the measured 
depths of the layer interfaces were 12 cm, 22 cm, and 33 cm. Each of the first three columns in the 
Ground Truth spreadsheet should be filled with this information as shown in Figure 67. 

 
Figure 67: Spreadsheet. 

The 5th, 6th and 7th columns of the spreadsheet shown in Figure 67 were automatically calculated by 
RADAN. The Data X shows the location of the nearest scan containing the layer pick, Time is its arrival 
time, and V is the calculated velocity for the layer. If no picks are located within 20 scans of the core 
location, then zeros will appear in the last 3 columns. 

Once core data have been entered, the spreadsheet can be closed or left open. When the user saves the 
data as an ASCII *.lay file, the core data are stored in a separate ASCII file with the same name as the 
*.dzt file and the extension .gtr. Once this file has been created it will automatically open and its contents 
read by RADAN the next time the user opens the ASCII file, providing it is located in the same directory 
as the ASCII file. Alternatively, if the user saves the pick data in a *.bii file, all of the ground truth 
information will be stored with the picks in the *.bii file. 

The velocities calculated from core data can be used to calculate layer depths. To change the velocities of 
existing picks, use the select block or select range picking tool and move the selected region over the 
picks that need to be changed. Then, click the right mouse button to bring up the pick options as shown 
and select the Change Pick Velocity option. Proceed to change the selected pick velocities as directed in 
the dialog. 
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To specify all new layer picks to have velocities calculated from the ground truth data, the velocity option 
must be changed from the Layer Properties Dialog page accessed through the Layer Options menu item.  

When ground truth data from more than one core are entered in the Ground Truth spreadsheet and the 
user selects core data as the velocity option for picks, the velocity used for each pick is obtained from the 
nearest core. 

Any changes in core data are automatically updated in the picks that have core data calculated velocities. 

Manipulating the Layer Options 
This tabbed dialog box is accessed by selecting the Layer Options item from the Interactive Interpretation 
Main menu (Figure 61). Once again, this pop-up menu is accessed by right-clicking on the data window 
in Interactive Interpretation. You can select one of the 6 pages: Filters, Display, Properties, Layer Names, 
and Other options by clicking on the corresponding tab. 

Filters 
Data can be filtered according to several statistical parameters. By default, filtering is disabled and the 
parameter boxes are inactive. The user has to uncheck the Disable Filters box in order to enable filtering 
and adjust the desired filter parameters. The filter items are statistics calculated for each layer. The data 
can be filtered according to the normalized reflection amplitude or another amplitude criteria using 
column 1. The -40 appearing in column 1 (Figure 68) indicates that all reflections associated with each 
layer that have normalized amplitudes less than –40 dB will appear as a different, user-defined, color in 
the window panes. These are known as filtered picks. 

The second column in Figure 68 is the filter option for the deviation of picks from a least-squares fit line 
through a segment of the data defined by the Statistics Layer Length. Figure 68 shows that all layer picks 
with deviations greater than 0.03 m will be filtered out (shown as a different color in the window). 
Filtering points using their deviation from a least-squares fit line is effective in eliminating spurious 
reflections from the database. 

The third column in Figure 68 is the Minimum Percent Scans filter option. The percent scans containing 
the layer surrounding each reflection point is calculated for each reflection. This calculation is performed 
using the Statistics Layer Length entered in the bottom of the page.  
Very discontinuous layers can be filtered out (shown as a different color in the window) using this option. 

The Statistics Layer Length shown on the bottom of the page is used in the calculation of Maximum 
Deviation and Percent Scans statistics. 

 
Figure 68: Filters page of the Layer Options dialog box. 
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Display 
This dialog (Figure 69) controls the appearance of picks representing each layer. 

Color: The different layer pick colors available include: yellow, red, green, blue, brown, gray, and black. 
Filtered Points Color selection will display the filtered points in a distinct color. 

Size: The size of the picks shown on the screen can be varied using this option. The number shown is the 
diameter of the pick in pixels. Pick sizes can be varied from 0 to 10 pixels. Setting the pick size to 0 will 
prevent the picks for the specified layer from being drawn on the computer screen. 

Add Black Outline around Points: This option is used to add or delete a black outline around each 
pick. Normally the black outline enhances individual picks. However the black outline may be 
undesirable if multiple picks are placed very close together because the black outline will prevent the user 
from observing the color of the pick. 

 
Figure 69: Display page of the Layer Options dialog box.  

Properties 
The layer properties dialog page allows the user to specify the criteria used to pick the layer reflections 
and the velocity used to calculate the layer depth (thickness). Figure 70 shows the layer property options. 

Bottom Picking Criteria: These criteria are used when the user adds reflection picks using the picking 
tool. Each time the user adds a pick, a search is performed to locate the corresponding feature of the 
reflection that will be used to identify the reflection arrival time and amplitude. The different criteria 
include: Positive Peak, Negative Peak, Absolute Amplitude Peak and None. When the picking tool is the 
Single Point and the None criteria is selected, the location and amplitude of the reflection is determined 
by the exact position of the mouse cursor over the data. Otherwise the nearest reflection peak meeting the 
chosen criteria is selected. Positive Peak is the default for all road subsurface layers. 

Layer Velocity: Sets the propagation velocity used to calculate the depth of each layer. If the Automatic 
option box is selected, the velocity will be automatically calculated for each radar scan (see the section on 
Horn Antenna Processing Theory in Part 1.2). The other options are: (1) User-specified, (2) Core Data, 
and (3) Velocity Analysis File. The Velocity analysis option is most commonly used for geological 
investigations where a common-midpoint file has been collected and processed using the Velocity 
Analysis Option in RADAN. 
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Interpolation Type: Selects Linear or Nearest Peak as the method used to interpolate points within the 
selected data block or range. The nearest neighbor method involves a search for the nearest peak between 
existing picks. The linear interpolation method does not perform any peak searching and simply picks 
points in scans based on a straight line drawn between the nearest 2 picks. The Nearest Peak interpolation 
is recommended because it preserves reflection amplitude information. Linear Interpolation may prove 
helpful in situations where undesired RF interference is adversely affecting the layer tracking process. 

Note: If linear interpolation is used, the automatic velocity calculation method should not be selected for 
layers below the interpolated layer. 

 
Figure 70: Properties page of the Layer Options dialog box. 

Note: Changes made to the items in the Properties page will only be applied to new picks. For existing 
picks the user must use the Select Block or Select Range to modify pick velocities. 

Layer Names 
The Layer Names page permits the user to specify a name for each layer. For example, for a typical road 
structure, the user may want to rename Layer 1 as Wearing Course, Layer 2 as Base and Layer 3 as 
Subbase. Layer name changes are shown in all dialogs and will be output to the ASCII file when the user 
performs the next ASCII file save (see the Save Changes section). 

 
Figure 71: Layer Names page of the Layer Options dialog box. 
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Other 
The Other page contains two separate options.  

Maximum Number of Layers: Maximum number of layers that can be traced in the current data file. It 
is recommended that the user select the minimum # of layers required for the project. Additional layers 
require more memory allocation and decrease program performance. A maximum of 7 layers is permitted. 

 
Figure 72: Global options page of the Layer Options dialog box. 

Vel. Analysis File: The Velocity analysis option is most commonly used for geological investigations 
where a common-midpoint file has been collected and processed using the Velocity Analysis process in 
RADAN. Enter output file from the Velocity Analysis process here to make these velocities available for 
picked layers. After the velocity analysis file is entered here, these velocities can be specified for new 
picks using the Properties Page or on existing picks by using the select block/select range option and 
selecting Pick Mod. Options from the drop-down menu. 

Target Options: Clicking on the Target Options menu item from the Main Menu opens up a list box 
containing the names and properties of all of the targets as shown in Figure 73. 

 
Figure 73: Target Options list accessed by selecting Target Options from the Main Menu. 

Initially, the target list will be empty. Targets are added by clicking . Each time the user 
clicks New Target, a new target name and its properties are added to the list. Figure 74 shows the target 
rebar that has just been added by clicking New Target. 
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Figure 74: Default target showing up following clicking . Target properties are edited by placing 
the mouse cursor over the target name, as shown, and double-clicking. 

The new target properties are edited by placing the mouse cursor over the target name as shown in Figure 
74 and double-clicking. This procedure opens up the dialog shown in Figure 75. 

 
Figure 75: Target Parameters dialog accessed by double-clicking on the target name. 

A description of each target parameter follows: 

Name: The name of the target. This name will appear in the spreadsheet and in the output ASCII file. 

Color: The color of the circle drawn at the target location in the data pane and corresponding target depth 
in the depth pane.  

Size: The size, in pixels, of the circle drawn at the target location in the data pane. 

Diameter: The diameter of the target. The width of the circle drawn in the depth pane is directly 
proportional to the target diameter when this value is greater than zero. When this value is zero, the size 
of the target circle drawn in the depth pane corresponds to the specified pixel size. 

Picking Criteria: The criteria used to pick targets in the data. The options are: (1) Positive Peak, (2) 
Negative Peak, (3) Absolute peak, and (4) None. When options 1-3 are used, the location of the target will 
correspond to a reflection peak. For option (4), the location of the target will directly correspond to the 
location of the mouse cursor or select block. 
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Velocity Calc.: Sets the propagation velocity used to calculate the depth of each target. The options are: 
(1) User-specified, and (2) Core Data. To enter a user-specified option, select Specify and enter the value 
in the box next to Default Velocity. 

Velocity: This is the user-specified velocity. 

Lock Vel: Checking this box prevents the user from selecting a different velocity method or user-
specified velocity for individual targets within the group of targets possessing the same target name. 

Hide: Checking this box hides all the target picks from view and prevents them from being selected using 
the select block or select range picking tools. 

Link: Checking this box connects the target picks together to form pipes and other linear objects that can 
be viewed in RADAN QuickDraw This option is only available for users who have purchased the I3D 
and QuickDraw modules. 

Global Options 
The Global Options dialog is accessed from the Global Options menu item in the Main menu. This dialog, 
shown in Figure 76, contains two adjustable options. 

 
Figure 76: Global Options dialog accessed by selecting Global Options from the Main Menu. 

Single Pt. Search Length: This option permits the user to select the search distance when adding single 
points. There are two options: (1) Closest Peak and (2) Cursor Length. The closest peak search type will 
perform a search until the first peak is located or the start or end of the scan is reached. In other words, the 
search may potentially extend over the entire scan. The Cursor Length search method only performs a 
search for a peak over the vertical length shown by the mouse cursor. The Closest Peak method is the 
default option. 

Amplitude Values: This option allows the user to specify how the amplitude values for each layer are 
calculated. The different options are: (1) Data Units, (2) dB, (3) Normalized dB, and (4) Corrected dB. 
The data units option provides the layer bottom reflection amplitudes in the actual data values. The dB 
option converts the data units amplitudes to decibels (dB) by using the equation 20*log10(x) where x is 
the absolute value of the data amplitude. The normalized dB option normalizes the data amplitude relative 
to 32767 before converting to dB. The Corrected dB option corrects for amplitude loss related to 
reflections from preceding layers. The corrected amplitude would therefore be a more representative 
value of the portion of energy reflected at the layer bottom. The importance of this value is that is can be 
used as one parameter in the assessment of the integrity of the layer bottom reflection. This option is only 
available with horn antenna data processed through the Road Structure module. 
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Save Changes 
It is a good idea to periodically save any work you have done or changes you have made. You have three 
options to save. 

Current File: Selecting this option will overwrite the existing .LAY file with any changes that you have 
made. 

New Filename>Save As Is: If you select this option you will get to specify a new name for the .LAY 
file. It will not delete the old .LAY file. You can also choose to save it as a Compressed Binary file (.BII) 
to save disk space. 

New Filename>Save Options: This will bring up a window that will allow you to modify your data 
output. 

 
Figure 77: Save Options 

Selected Picks: Chooses which data picks to apply these parameters. 

Interval Output: This allows you to select the desired output spacing and the parameters that you want 
to output. This feature is useful when you need to decimate large data areas. 

Save only Picks at User Marks: Only those picks that coincide with a user mark will be save. 

Convert Velocities to Dielectric Permittivity: This will output V as a unitless dielectric value. 

Exporting a KML File for Use in Google Earth 
A KML file is a file type used to display geographic data in an earth browser, such as Google Earth and 
Google Maps. KML files have a tag-based structure with names and attributes used for specific display 
purposes. In RADAN you can export certain kinds of information as a KML file and easily view that 
information in Google Earth. This section discusses exporting layers identified in Interactive 
Interpretation. 

Note: This is new functionality provided on a trial basis to users of 6.6. See the note on page 2 for more 
information. 

Note: In order to create a KML file, you must have collected the data with GPS. 
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To export, right click on the Interactive Interpretation data pane and go to Save Changes>Export. You 
will see the dialog pictured in Figure 77. 

 
Figure 77: KML file Export Options. 

Layer: Selects the Layer that you want to export. If you have multiple layers, you must export them one 
at a time. 

Channel: Selects the data channel to export. You can export different channels if you have collected a 
multi-channel file. 

Output Parameter: This can be pick depth, amplitude, velocity, or time depending on the type of data 
that you want to depict. 

Distance Placemarks/Distance Interval: This option outputs a notation at a prescribed distance. 

Line width: The KML output line width in pixels. 

Minimum/Maximum: This sets the range of output values specified in the Output Parameter option. 

Number of Intervals: The number of evenly spaced breakpoints for the output data. 

Range/Colors: The range will be set by the number of output intervals. You can decide to code different 
intervals with colors. 

The output of this is a KML file with the same root name as the ASCII pick LAY file. To import into 
Google Earth, simply drag this file onto Planet Earth and it will zoom to the given location of the data. 

 

Exiting the Interactive Interpretation Session 
Exit the Interactive Interpretation session by clicking the left mouse button on the  at the top right 
corner of the Interactive Interpretation window or by exiting RADAN. If changes have not been saved, 
you will be prompted to save them to the current output file. 
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Chapter 5: Additional Features for Users of 
FWD/GPR Systems 

GSSI has worked with Foundation Mechanics, Inc. to integrate GPR technology with the JILS Falling 
Weight Deflectometer (FWD) system. The two technologies are complimentary because pavement 
thickness measurements obtained with the GPR allow a more accurate, calibrated FWD reading. 

The following steps address a particular need in FWD studies. That need is to process a large number of 
short GPR data files as rapidly as possible while in the field so that the information can be fed into the 
FWD analysis software. In order to do this, we need to make a few changes to the way we collect and 
process data. The sequence is presented in the next few pages. Be sure to read and understand Chapters 3 
and 4 before proceeding. 

5.1 Collecting Data and On-the-Fly Processing 

Project Setup 

1 Create a New Project following the instructions in Parts 3.1 and 3.2. 

2 Create a metal plate calibration file (bumper jump) as described in Part 3.3, but be sure to write 
down the name of the file. 

Preparing the Autorun Macro 

1 From the collection screen, select View>Radar. 

2 Go to View > Toolbars and make sure that the Process Bar has a check next to it. 

3 Go to File and open the Metal Plate File. It will look similar to Figure 78. 

 
Figure 78: Metal Plate File. 

4 Click on the Generate Horn Calibration File button  or go to Process>Infrastructure> 
Generate Horn Calibration File. Make sure that Antenna Config is set to RSA Profile and select 
the appropriate antenna under Antenna Type. Click OK. 
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5 Save this file in the Horn Cal directory. This directory is part of your RADAN program, you do 
not need to create it (Figure 79). Pull down the Save In menu and browse to find the Horn Cal 
folder. It will be located in C:\Program Files\GSSI\RADANXP\. Make sure that the CZT file is 
saved to this directory. After it saves, you will see the short calibration file on the screen. Close 
that short file and leave the long, wave file on the screen. 

 
Figure 79: Horn Cal Folder. 

6 Create Autorun Macro. Go to View > Toolbars and make sure that the Macrobar is checked. 

Click on the New Macro button,  and browse to find the Auto Run Macro folder. This folder 
is located at C:\Program Files\GSSI\RADANXP\. Type in a name for the macro and save it in the 
Auto Run Macro folder. If there are multiple macros in the folder, the software will use the one 
that comes first in alphabetical order. For example, if there are three files: AMACRO.CMF, 
BMACRO.CMF, and CMACRO.CMF, when the software goes to use the macro it will choose 
AMACRO.CMF. Click Save. You will see the macro name displayed in the lower right-hand 
corner of the screen. 

7 Add processes to the Macro. Click on the Reflection Picking button,  and select Horn Cal 
File from the Current pull down menu, then click finish. Next select Horn Layer Interpretation 

. Make sure that Automatic mode is selected and the Number of Layer is set to 1. Click 

Finish. Click the Close Macro button , and close any data files. The Autorun Macro is now 
ready. 

Collect the Data 

1 Collect a Data file. Go to View and check RADAR. Make sure the metal plate is NOT under the 
antenna anymore.  

2 Click on the green box to load the project and initialize the data file. 

3 Click the green arrow to begin collection. Wait until the window fully maximizes before moving. 

4 Drive to the end of the survey segment and click the red square with the white dot to stop and 
save the data file. 
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5 If you want to run the Autorun macro process and process each file on the fly, move on to the 
next section. If you want to collect a new data file, go back to Step 2. 

On the Fly Processing with the Autorun Macro. 
1 After Step 4 of the previous section you will be looking at the blank, blue SIR-20 collection 

screen. Push the ESC (Escape) key several times to make sure that there are no menu items 
highlighted and no drop down menus showing. 

2 Press Shift-F7 on the keyboard. The last data file will be automatically opened and the processing 
steps contained in the Autorun macro will be applied. Save the data with a unique name. 

3 The data file will automatically open in Interactive Interpretation. Edit the yellow picks if needed. 

4 The data are now saved as a spreadsheet. Follow your JILS FWD documentation for instructions 
to integrate your GPR data with the FWD data. 

5 Press F3 to return to the collection mode and to initialize the antenna to collect another data file. 

5.2 Using the Autorun Macro to Process Previously 
Collected Data 
This section will cover use of the Autorun macro to speed up the processing of data that you have already 
collected. It can be used two ways. You can either open and process each file individually, or you can 
stitch the files together to form one single long file and process it with the Autorun macro. 

You will still need to create the macro. 

Creating an Autorun Macro for Post-Processing. 
1 Go to File and open the Metal Plate File. It will look similar to Figure . If you have already 

created a calibration file, skip to Step 4. 

 
Figure 80: Metal Plate File. 

2 Click on the Generate Horn Calibration File button  or go to Process>Infrastructure> 
Generate Horn Calibration File. Make sure that Antenna Config is set to RSA Profile and select 
the appropriate antenna under Antenna Type. Click OK. 
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3 Save this file in the Horn Cal directory. This directory is part of your RADAN program, you do 
not need to create it. Pull down the Save In menu and browse to find the Horn Cal folder. It will 
be located in C:\Program Files\GSSI\RADANXP\. Make sure that the CZT file is saved to this 
directory. After it saves, you will see the short calibration file on the screen. Close that short file 
and leave the long, wave file on the screen. 

 
Figure 81: Horn Cal Folder. 

4 Create Autorun Macro. Go to View > Toolbars and make sure that the Macrobar is checked. 

Click on the New Macro button,  and browse to find the Auto Run Macro folder. This folder 
is located at C:\Program Files\GSSI\RADANXP\. Type in a name for the macro and save it in the 
Auto Run Macro folder. If there are multiple macros in the folder, the software will use the one 
that comes first in alphabetical order. For example, if there are three files: AMACRO.CMF, 
BMACRO.CMF, and CMACRO.CMF, when the software goes to use the macro it will choose 
AMACRO.CMF. Click Save. You will see the macro name displayed in the lower right-hand 
corner of the screen. 

5 Add processes to the Macro. Click on the Reflection Picking button,  and select Horn Cal 
File from the Current pull down menu, then click finish. Next select Horn Layer Interpretation 

. Make sure that Automatic mode is selected and the Number of Layer is set to 1. Click 

Finish. Click the Close Macro button , and close any data files. The Autorun Macro is now 
ready. 

First Method: Process Files One at a Time 
For this method, make sure that the macro toolbar is displayed. Go to View>Toolbars>Macrobar and 
click it. The macro toolbar looks like: . 
1 Go to File > Open or . Select the file that you want to process. 

2 Click the Autorun macro button and the macro toolbar . 

3 Save the data with a unique filename. 

4 The data will open in Interactive Interpretation. Edit the automatic picks as necessary. 
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Second Method: Process all the Files Together 
For this method, make sure that the macro toolbar is displayed. Go to View>Toolbars>Macrobar and 
click it. The macro toolbar looks like: . 
1 Select File > Append Files. You will see a window like Figure . 

 
Figure 82: Append Files. 

2 Double-click on the files in the order in which you want them to go together. You will see them 
filling in the list at the bottom of the window. 

3 Click Done. RADAN will stick the files together. Save the file with a unique name. 

4 Click the Autorun macro button and the macro toolbar . 

5 Save the data with a unique filename. 

6 The data will open in Interactive Interpretation. Edit the automatic picks as necessary. 

 



Geophysical Survey Systems, Inc. GPR Inspection of Road Structures 
  

MN43-183 Rev H 70 



Geophysical Survey Systems, Inc. GPR Inspection of Road Structures 
  

MN43-183 Rev H 71 

Appendix A: Suggestions for Further Reading 
Blahunt, Richard E., Algorithms for Digital Signal Processing, Addison-Wesley, 1985, 358pp. 
Knoll, M.D., and Knight, Rosemary, 1994, Relationships Between Dielectric and Hydrogeologic 
Properties of Sand-Clay Mixtures, in Proceedings of the Fifth International Conference on Ground 
Penetrating Radar, V. 1, pp. 45-52. 
Kutrubes, D. L., 1986, Dielectric Permittivity Measurements of Soils Saturated with Hazardous Fluids: 
M.Sc. thesis, Colorado School of Mines, Golden, CO., 300pp. 

Olhoeft, G.R., 1987, Electrical properties from 10 -3 to 10 9 Hz, Physics and Chemistry: Physics and 
Chemistry of Porous Media II, Am. Inst. of Phys. Conf. Proc., Banavar, J.R., Koplik, J., and Winkler, 
K.W., eds., NY, Am. Inst. of Phys., pp. 281-298. 

Petroy, D., and Roberts, R., 1997, Spatial Sampling for Ground Penetrating Radar Road Evaluation, Proc. 
Seventh Int. Conf. On Structural Faults and Repair, Edinburgh, Scotland, July, 1997, Engineering 
Technics Press, pp. 119-131. 

Roberts, R.L. and Petroy, D., 1996, Semi-Automatic Processing of GPR Data Collected over Pavement, 
Sixth Annual Conference on Ground Penetrating Radar, Tohuku University, Sendai, Japan, September, 
1996, pp. 347-352. 

Smith, Stanley S. and Scullion, Thomas, Development of Ground-Penetrating Radar Equipment for 
Detecting Pavement Condition for Preventive Maintenance, Strategic Highway Research Program, 
National Academy of Sciences, Washington, D.C., USA, 1993. Phone: 202-334-3774. 

Yilmaz, Ozdogan, 1987, Seismic Data Processing; Investigations in Geophysics, Vol.2, Society of 
Exploration Geophysicists; Tulsa, Oklahoma, 526pp. 

 



Geophysical Survey Systems, Inc. GPR Inspection of Road Structures 
  

MN43-183 Rev H 72 



Geophysical Survey Systems, Inc. GPR Inspection of Road Structures 
  

MN43-183 Rev H 73 

Appendix B: Calibration File Collection 
Procedure 

Overview 
Data files collected over pavement that are processed using RADAN’s Road Structure Assessment 
Module require a calibration file. The calibration file for horn antennas is collected with the antennas 
positioned over a metallic sheet. An optional air file (normally not used) is obtained with the antennas 
turned upside down so that they are radiating into the air.  

• The metal plate calibration file should be obtained just prior to beginning data collection over a 
roadway or immediately after roadway data collection has been completed.  

• Make sure the SIR-20 system has been running for at least 10 minutes with the scans showing on 
the screen before collecting the calibration file.  

• It is recommended to collect a calibration file each time the SIR system has to be shut down for an 
extended period of time (>5 minutes). 

SIR System Software Settings 
For the horn antennas, the same system settings as for data collection over pavement should be used with 
the exception that: 
1 Make sure the gain is set to AUTO. The Auto-Gain feature will automatically adjust the gain to 

account for the metal plate. The metal plate must be placed under the antenna prior to starting the 
horn antenna calibration file data collection process. 

2 The Antenna Calibration File box must be checked in the Project settings by editing the project.  

Calibration Data Collection 
1 Once the settings are adjusted correctly, park the data collection vehicle at least 3 m (10') from 

any objects that may reflect radiated energy back toward the receiving antenna. These objects 
include curbs, walls, lamp posts, other cars, and people.  

2 Next, place a large metal plate underneath the antennas.  

• For the Model 4208 antenna, the edges of the metal plate should extend beyond the long sides 
of the antennas at least 22 cm (9") and beyond the short sides at least 50 cm (20"). A typical 
metal plate used at GSSI for Model 4208 antenna calibration is approximately 1x1.6 m  
(3' x 5"). 

• We recommend 1.2 x 1.2 m (4’x4’) metal plate dimensions for calibrating the Model 4108 
and 4105 antennas. The metal plate should be centered beneath the midpoint between the 
antennas. 

3 Begin file data collection and collect approximately 200 scans.  
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4 Next, have one or more persons stand on the bumper of the vehicle and jump up and down in 
unison.  

5 Collect approximately 2 full screen widths of data before pressing the stop button. The output 
file, referred to as a raw calibration file, should look similar to the data file shown in Figure 80. 

6  
Figure 80: Raw calibration file obtained with Model 4105 2 GHz horn antenna. 
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Appendix C: Glossary of Terms 
Antenna: a paired transmitter and receiver that sends electromagnetic energy into a material and receives 
any reflections of that energy from materials in the ground. Also called a transducer. Antennae are 
commonly referred to by their center frequency value (i.e. 400MHz, 1.5Ghz). This frequency determines 
the depth of penetration and the size of the objects or layers visible. 

Attenuation: the weakening of a radar pulse as it travels through different materials.  

Center Frequency: the median transmit frequency of an antenna. The antenna will also transmit energy 
at a frequency range of 0.5-2 times its center value. For example, a 400 MHz antenna may actually 
transmit at a range from 200-800 MHz. 

Clipping: occurs when the amplitude of a reflection is greater than the maximum recordable value. The 
system disregards the true value of the reflection and writes in the maximum allowable value. Clipping 
appears in the O-Scope as signal that “goes off the scale” at the sides of the window.  

Dielectric permittivity: the capacity of a material to hold and pass an electromagnetic charge. Varies 
with a material’s composition, moisture, physical properties, porosity, and temperature. Used to calculate 
depth in GPR work. 

EM: Acronym for electro-magnetic. 

FCC: Acronym for Federal Communications Commission. The United States governmental body that 
oversees the UWB industry of which GPR is a part. 

Gain: amplifying the signal to certain section of a radar pulse in order to counteract the effects of 
attenuation and make features more visible.  

GHz: Acronym for Gigahertz. A measurement of frequency equal to one billion cycles per second. 

GPR: Acronym for Ground Penetrating Radar. 

Ground-coupling: the initial entry of a radar pulse into the ground.  

Hyperbola: an inverted “U.”  The image produced in a vertical linescan profile as the antenna is moved 
over a discrete target. The top of the target is at the peak of the first positive (white in a grayscale color 
table) wavelet. 

Interface: the surface separating materials with differing dielectric constants or conductivity values.  

KHz: Acronym for Kilohertz. A measurement of frequency equal to one thousand cycles per second. 

Linescan: commonly used method of depicting a radar profile. Linescans are produced by placing 
adjacent scans next to each other and assigning a color scheme to their amplitude values.  

Macro: a preset list of processing options that may be applied to perform repetitive functions on an entire 
dataset. Macros may be created and edited to include different functions (see RADAN manual for 
addition information). 

Mark: point inserted along a survey line manually by the operator or at preset intervals.  
MHz: Acronym for Megahertz. A measurement of frequency equal to one million cycles per second. 
Migration: mathematical calculation used to remove outlying tails of a hyperbola and to accurately fix 
the position of a target. 
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Nano-second: unit of measurement for recording the time delay between transmission of a radar pulse 
and reception of that pulse’s reflections. Equal to one one-billionth of a second. 
Noise: unwanted background interference that can obscure true data.  
Noise floor: time depth at which the noise makes target identification impossible. 
nS: see Nano-Second. 
Oscilloscope: device used to view and measure the strength and shape of energy waves. Common term 
in GPR industry for a method of data display showing actual radar wave anatomy. 
Passband: the frequency range at which the antenna is emitting energy. It is roughly equivalent to 0.5-2 
times the center frequency. 
RAM: Acronym for random access memory. Temporary memory in which a computer stores information 
used with a running program, or temporarily stored data before it is written to a hard drive. 
Range: the total length of time (in nanoseconds) for which the control unit will record reflections. Note: 
indicates two-way travel time. 
RF: Acronym for radio frequency. 
Sample: a radar data point with two attributes: time and reflection amplitude. A third attribute, position, 
is assigned by the user. Under-sampling will produce a scan wave that does not contain enough 
information to draw a smooth curve. It may miss features. Over-sampling will produce a larger data file. 
Samples/Scan: the number of samples recorded from an individual radar scan. Commonly set to 512.  
Scan: one complete reflected wave from transmission to reception, sometimes called a trace. 
Survey wheel: wheel attached to an antenna and calibrated to record precise distances. Necessary for 
accurate data collection. 
Time-slice: a horizontal planview of amplitude values drawn from adjacent vertical profiles. The time-
slice is produced for a particular time-depth and is vital for understanding the horizontal positions of 
features in a survey area.  
Time window: the amount of time, in nano-seconds, that the control unit will count reflections from a 
particular pulse. Set by the operator. 
Transect: a line of survey data. An area is systematically surveyed by recording transects of data at a 
constant interval. The transects are then placed in their correct position relative to each other in a 
computer and horizontal time-slices are produced. 
UWB: Acronym for Ultra-Wide Band. Refers to the wide frequency band of emissions put out by a GPR 
device. 
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